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About This Guide

This guide covers the following information:

Part 1: Getting Started — Introduces the AOM and describes supported
program and script languages.

Part 2: Using the AOM — Describes configuration and customizations
necessary to implement custom applications and how to use Java, JavaScript,
JScript, VBScript, COM, and C++ to access the AOM.

Part 3: Programming and scripting techniques — Provides descriptions and
examples of using Arbortext Editor and the AOM to perform basic document
operations and to work with events.

Part 4: Interfaces — Details the W3C and Arbortext interfaces (and their
attributes, enumerations, and methods) supported by the AOM and the
Arbortext Publishing Engine.

Prerequisite Knowledge

The Programmer's Reference assumes advanced skill using Java, JavaScript,
JScript, VBScript, or COM (Component Object Model). If you're creating a
Arbortext Publishing Engine application, you also need to be familiar with Java
servlets, servlet containers, web servers, the HTTP protocol, and the SOAP
protocol.

Documentation for PTC Products

You can access PTC product documentation using the following resources:

Online Help
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Click Help from the user interface for online help available for the product.

» Reference Documentation

PDFs of reference information are available from the Product Documentation
area of www.ptc.com/support.

Select the Arbortext tab to access the Arbortext Reference Documentation
link.

» Help Center

Help Centers for the most recent product releases are available from the
Product Documentation area of www.ptc.com/support.

Select the Arbortext tab to access the Help Centers link.

You must have a Service Contract Number (SCN) before you can access the
Arbortext Reference Documentation or Help Centers links. If you do not have an
SCN, contact PTC Technical Support or Customer Care Departments using the
contact instructions found in your Customer Support Guide.

Global Services

PTC Global Services delivers the highest quality, most efficient and most
comprehensive deployments of the PTC Product Development System including
Creo, Windchill, Arbortext, and PTC Mathcad. PTC’s Implementation and
Expansion solutions integrate the process consulting, technology implementation,
education and value management activities customers need to be successful.
Customers are led through Solution Design, Solution Development and Solution
Deployment phases with the continuous driving objective of maximizing value
from their investment.

Contact your PTC sales representative for more information on Global Services.

Comments

PTC welcomes your suggestions and comments on our documentation. You can
submit your feedback to the following email address:

arbortext-documentation@ptc.com

Please include the following information in your email:

e Name
* Company
*  Product

*  Product Release

* Document or Online Help Topic Title
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Level of Expertise in the Product (Beginning, Intermediate, Advanced)

Comments (including page numbers where applicable)

Documentation Conventions

This guide uses the following notational conventions:

Bold text represents exact text that appears in the program's user interface.
This includes items such as button text, menu selections, and dialog box
elements. For example,

Click OK to begin the operation.
A right arrow represents successive menu selections. For example,
Choose File » Print to print the document.

Monospaced text represents code, command names, file paths, or other
text that you would type exactly as described. For example,

At the command line, type version to display version information.

Italicized monospaced text represents variable text that you would
type. For example,

installation-dir\custom\scripts\

Italicized text represents a reference to other published material. For example,

If you are new to the product, refer to the Getting Started Guide for basic
interface information.

Conventions Used in This Guide

In addition to the conventions listed earlier, this guide uses the following
notational conventions:

Square braces ([ ]) denote optional parameters which may be omitted. For
example:

insertBefore(newChild[, refChild])

A vertical bar (]) separates parameters in a list from which one parameter must
be chosen or used. For example:

allowinvalidmarkup {on | off}

List of Terms

The following terms are used throughout this guide.
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*  AOM — Arbortext Object Model.

» attributes — [Definition TBD]

* interfaces — [Definition TBD]

* methods — [Definition TBD]

* multicell — A rectangular array of spanned cells in a table.
*  OID — [Definition TBD]

* properties — [Definition TBD]

* scripts — [Definition TBD]

*  TOID — Table Object Identifier.

Where to Get More Information

Supporting documentation and related Javadoc for Arbortext Editor and Arbortext
Publishing Engine can be found in the Arbortext Editor Help Center. You can
open the Help Center from the Arbortext Editor Help menu. ACL (Arbortext
Command Language) documentation is included in the Help Center and is not the
focus of the Programmer's Reference.

If you're using the Arbortext Publishing Engine, be sure to review Installation
Guide for Arbortext Publishing Engine and Configuration Guide for Arbortext
Publishing Engine for extensive information on Arbortext Publishing Engine
installation, setup, and configuration.

Training classes are also available. For more information, visit www.ptc.com.

If you are looking for more general information on programming or scripting
languages, you may want to consult the following resources:

» Thinking in Java, by Bruce Eckel. Published by Prentice Hall PTR.

* Oracle has extensive Java information available at its web site www.oracle.
com/technetwork/java/index.html. The tutorials are especially helpful to
beginners.

» JavaScript: The Definitive Guide, by David Flanagan. Published by O'Reilly
and Associates Inc.

* Mozilla has extensive JavaScript information available at its web site www.
mozilla.org.

+ ECMA International (European Computer Manufacturers Association) has the
ECMAScript Language Specification, which is the standard used for
JavaScript, available at its web site www.ecma-international.org.

*  Microsoft has extensive information about JScript, VBScript, ActiveX
scripting host, and COM available at its web site msdn.microsoft.com.
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Supported Program and Script

Languages

You can write programs and scripts in several supported languages. The following
table lists the supported languages and their descriptions:

Supported Program and Script Languages

Language Description

Java Cross-platform, object-oriented programming language.

COM Windows Component Object Model. COM is not actually
a language but a standard. It is supported by several
languages, including C++ and Visual Basic.

JavaScript Cross-platform, object-oriented scripting language, not
directly related to Java. The standard it follows is called
ECMAScript.

JScript A COM-based, loosely-typed scripting language, not
directly related to Java but similar to JavaScript.

VBScript A COM-based scripting language that is a subset of the
Visual Basic for Applications programming language.

ACL Arbortext Command Language, a proprietary scripting
language from PTC Inc.
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Introduction to the Arbortext Object Model (AOM) ...........iviiiiiiiiiiiiiie e 36
Introduction to the Document Object Model (DOM) ........coouiiiiiiiiiiieiieee e, 36
Using the DOM Supportin AOM .......oounii e 37

The AOM (Arbortext Object Model) delivers much of ACL's functionality
available to non-ACL programmers. This includes support for the W3C DOM
(Document Object Model) standard. Specifically for Arbortext Editor and
Arbortext Publishing Engine, the DOM is extended with several additional
interfaces, attributes, and methods.

35



Introduction to the Arbortext Object
Model (AOM)

The AOM provides object-oriented programming access to Arbortext Editor and
Arbortext Publishing Engine. The AOM supports the W3C DOM (Document
Object Model) Core and Validation interfaces with extensions, and provides many
additional interfaces for Arbortext-specific features that are not part of the DOM.
The Arbortext extensions to the DOM use a naming convention where A (for
Arbortext) is prepended to the DOM interface name; for example, the Arbortext
extension for the DOM Node interface is ANode.

The AOM supports bindings to Java, COM (Component Object Model), and C++.
The AOM also provides scripting access to its interfaces using JavaScript, JScript,
VBScript, and the ACL (Arbortext Command Language).

The following diagram shows the relationship between Arbortext Editor and
Arbortext Publishing Engine, the DOM and AOM interfaces, and programs or
scripts accessing the DOM and AOM.

COM C++ Programs
Java Programs !
JavaScript VBScript C++ Programs
Jscript
Java COM fonds

Binding Binding Binding

L

DOM and AOKM
Interfaces

:

Arbortext Editor and Publishing Engine

Java programs and JavaScript communicate with the DOM and AOM interfaces
using the Java Binding. COM C++ programs, VBScript, and JScript communicate
with the DOM and AOM interfaces using the COM Binding. C++ Programs
communicate with the DOM and AOM interfaces using the C++ Binding. The
DOM and AOM interfaces communicate with Arbortext Editor and the Arbortext
Publishing Engine.

Introduction to the Document Object
Model (DOM)

The Document Object Model (DOM) is a standards-compliant interface for
examining and modifying an XML or SGML document. The DOM Level 2
specification is a recommendation of the Worldwide Web Consortium (W3C)
comprised of several parts. Arbortext products implement the DOM Level 2
features as described in the following W3C specifications:
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*  Document Object Model (DOM) Level 2 Core Specification (http://www.w3.
org/TR/DOM-Level-2-Core)

*  Document Object Model (DOM) Level 2 Views Specification (http://www.w3.
org/TR/DOM-Level-2-Views)

*  Document Object Model (DOM) Level 2 Events Specification (http://www.
w3.org/TR/DOM-Level-2-Events)

*  Document Object Model (DOM) Level 2 Traversal and Range Specification
(http://www.w3.org/TR/DOM-Level-2-Traversal-Range), range only

Arbortext also implements the W3C Recommendation Document Object Model
(DOM) Level 3 Validation Specification dated 27 January 2004. (http://www.w3.
org/TR/2004/REC-DOM-Level-3-Val-20040127/) The validation interfaces are
implemented for both XML and SGML documents. (The DOM Level 3 Core
interface DOMConfiguration is not implemented in this release.)

Using the DOM Support in AOM

Some considerations and limitations for using DOM through the AOM can help
you determine your approach.

DOM Programming Considerations
The following programming considerations apply to all language bindings:
* Document context

The DOM assumes that the XML document being processed is well-formed,
but makes no assumptions about its validity. Because there is no way to
represent validity without departing from the DOM Level 2 standard, the
Arbortext Editor DOM interface ignores context checking. Therefore, it is
possible for the user-written program to make a document invalid that was
previously valid. However, users can context check the document once the
user-written program returns control to Arbortext Editor. Alternatively, the
user-written program can use the Ac1 interface to perform context checking.

e Performance issues

The DOM allows users to create NodeLi st objects that contain pointers to
every tag with a given name in a document or document subtree. Once
created, a NodeLi st is dynamically updated to reflect every tag insertion or
deletion. The existence of these objects is likely to slow tag insertion and
deletion in Arbortext Editor. Users should delete NodeList objects as soon
after use as practical.
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DOM Limitations

The Arbortext implementation of the DOM may be used with SGML documents.
Because the DOM portion of the AOM is XML- and HTML-based, features in
Arbortext Editor that are available only for SGML, but not for XML, are not
supported (such as TGNORE marked sections).

The DOM standard states that management of namespace-qualified elements and
attributes will be performed without the insertion or modification of namespace-
related XML attributes, at least until a document is actually written to disk.
Instead, Arbortext Editor inserts xm1ns and xmlns:prefix XML attributes as
needed to establish and maintain namespace/prefix bindings.

Arbortext Editor does not return the document type's internal subset, if any. The
internalSubset ofthe DocumentType interface will always return a null
string.

Using the DOM with SGML Documents

The DOM is designed to support XML documents. The DOM support for SGML
documents is limited to parallel support for XML. If you'll be working with
SGML documents, the DOM will ignore TGNORE marked sections and RCDATA
sections. If an element in an SGML document contains three sub-elements, and
one of the sub-elements is an TGNORE marked section or an RCDATA section,
user-written DOM programs will see only two sub-elements.
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Overview of Custom Programs and
Scripts

The Arbortext Editor and Arbortext Publishing Engine installations have directory
structures within them where you can place your custom scripts and programs.
The custom and the application directories are described in the following
sections.

The Custom Directory Structure

The Arbortext-path\custom directory has a subdirectory structure
designed to hold your custom programs and scripts and make them automatically
available during the session. At startup, these subdirectories are searched for Java,
JavaScript, JScript, VBScript, ACL, and composer configuration files. You can
also provide custom document types, entities, fonts, graphics, and native shared
libraries and DLLs. The supported file types are automatically accessed if they
reside in the appropriate subdirectory. Implementing your custom files using this
approach takes advantage of the startup sequence to automatically locate your
custom files. The Arbortext-path\custom directory and its subdirectories
are explained in detail in this chapter.

The Application Directory Structure

The Arbortext-path\application subdirectory can contain custom
applications as well as application software distributed by Arbortext. The
application directory must have one or more uniquely named subdirectories,
each containing a specific configuration file, application.xml, that conforms
to a specific format. At startup, the application directory is searched for
subdirectories and the presence of a valid application.xml file. In the
uniquely named subdirectory, all subdirectories of the custom directory are
supported. The custom application in a application then uses these
subdirectories in the same way as the custom directory structure. You can also
have additional subdirectories needed to support the implementation of this type
of custom application. Implementing your custom application using this approach
takes advantage of the startup sequence, supports delivering a completely selt-
contained custom application, and offers the option of setting the conditions for
whether the application should be loaded. The application directory is also
explained in this chapter.
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Description of the Custom Directory
Structure

When Arbortext Editor or an Arbortext PE sub-process starts, it can access custom
files placed in specific directories. At startup, it automatically looks for compiled
Java files (. class and . jar files), JavaScript, JScript, VBScript, ACL,
document type, publishing configuration and other types of files within the
Arbortext-path\customn directory structure.

You can have one or more custom directories outside the Arbortext-path
install tree. To specify a path list for their locations, set the APTCUSTOM
environment variable. The custom directory must be located using a file system;
HTTP references are not supported.

At startup, some search paths are automatically prepended with the path to a
custom subdirectory. Startup automatically sets some of these search paths using
a symbolic variable as a path specification. You can use symbolic parameters to
represent a search path in the context of the default search path, the location of the
install tree, or the locale.

If a directory supports more than one type of file, the file types are processed in
the following order:

* .acl (Arbortext Command Language) files

* .Js (JavaScript or JScript) files

* .class (Java) files

* .vbs (VBScript) files

For each file type, its files are processed in alphabetical order by file name.

The Arbortext-path\custom directory is processed at startup. If you add
custom applications and document types after startup, they're not recognized
during the session. If you're using Arbortext Editor, it needs to be closed and
restarted. If you're using Arbortext Publishing Engine, you need to stop and restart
the Arbortext Publishing Engine to re-initialize the Arbortext PE sub-processes.

custom.xml File

At the top level of the custom directory is the custom. xml file. Following is
the default version of this file:
<?xml version="1.0" encoding="UTF-8"?>
<!--Arbortext, Inc., 1988-2009, v.4002-->
<ApplicationConfiguration
xmlns="http://www.arbortext.com/namespace/doctypes/appcfg">
<Information>
<!--The following name will be shown in the New dialog
as the category for all document types in this
custom directory that do not specify a category.-->
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<Name>Custom Directory Name</Name>
</Information>
</ApplicationConfiguration>

This file is only used when you have a custom document type in the custom\
doctypes subdirectory, and you have not designated a category name for the
document type in the associated document type configuration (.dcf) file’s
NewDialog element. In this case, the name in the custom.xml file’s Name
element is used as the Category name for the document type(s) in the custom\
doctypes subdirectory in the New Document dialog box.

Subdirectory Structure

The following list describes each custom subdirectory and how it's used.
Arbortext Editor and Arbortext Publishing Engine look in these directories for any
references that use a relative path or have no specified path.

* classes subdirectory
Holds compiled Java .class and . jar files.

The Arbortext Editor and Arbortext Publishing Engine JVM Java class path
holds a list of directories and paths to . jar files. Any files matching * . jar
are prepended to the JVM Java class path. Then the classes parent
directory is prepended, putting it first in the JVM Java class path.

In cases where a class file occurs in more than one . jar file, you can extract
the preferred . class file from its . jar file and place it in a subdirectory
path of the classes directory to control which one takes precedent.

* composer subdirectory

Holds publishing configuration files (. ccf, .ent, and .xml files) and can
support a catalog file. Supports one level of subdirectories.

The default path is Arbortext-path\composer. If there are any
subdirectories of the custom\ composer directory, those subdirectories are
prepended to the publishing configuration path. Then the custom)\
composer parent directory is prepended to the path. If the custom\
composer directory contains a catalog file, that directory is also
prepended to the catalog path.

* dialogs subdirectory

Holds dialog files that can be accessed from custom applications, such as one
that uses the AOM Application.createDialogFromFile method.

The Arbortext-path\samples\XUI\preferences\pref
exts.zip contains a sample application that adds a tab to the Preferences
window as a way to extend preferences for custom applications. Refer to the
readme. txt file for more information.

42 Programmer's Reference



If there are any subdirectories of the custom\dialogs directory, those
subdirectories are prepended to the dialog path. Then the custom\dialogs
parent directory is prepended to the dialog path.

* ditarefs subdirectory

Holds content referenced by DITA documents when the reference is not
specified as either an absolute path name or a path name relative to the current
document directory. For example, the ditarefs subdirectory could hold
content referenced by topic references, content references, and so forth.
Supports one level of subdirectories.

The default DITA reference path is Arbortext-path\ditarefs. The
DITA references path can be set in the File Locations category of the Tools »
Preferences dialog box. You can also use the set ditapath option or the
APTDITAPATH environment variable to set the default path for DITA
references. If there are any subdirectories of the custom\ditarefs
directory, those subdirectories are prepended to the path. Then the custom)\
ditarefs parent directory is prepended to the path.

~ Note

Graphic references from DITA documents are resolved using the graphics
path list.

* dictionaries subdirectory

Holds user-defined dictionary files that can be used by the spelling checker.
Supports one level of subdirectories.

The default path is Arbortext-path\lib\proximity\userdict. If
there are any subdirectories of the custom\dictionaries directory,
those subdirectories are prepended to the dictionary path. Then the custom\
dictionaries parent directory is prepended to the dictionary path.

* doctypes subdirectory

Holds a custom catalog file and document type files. Supports one level of
subdirectories. Each document type should reside in a uniquely named
subdirectory of doctypes. The subdirectory should also contain a catalog
file for the custom document type. A doctypes subdirectory can also
contain a subset of the complete document type file set. You can place a
document type configuration file . dcf or stylesheets in a \custom)\
doctypes\doctype directory.

You can add a stylesheet to the list of stylesheets that displays when you make
a publishing request using one of the File » Publish choices. Arbortext Editor
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and Arbortext Publishing Engine search each \custom\doctypes\
doctype directory and aggregate the list of stylesheets. For example, you
can add stylesheets for the asdocbook built-in document type (asdocbook)
by placing them in Arbortext-path\custom\doctypes\
asdocbook.

If a document does not specify an Editor view stylesheet with a stylesheet
association PI, Arbortext Editor will first search first the document directory,
then the relevant \custom\doctypes\doctype directory, and finally the
original location for the doctype directory.

If the subdirectory contains only a . dcf file, it must conform to a naming
convention that expects the subdirectory and . dcf file name to reflect the
base document type name. For example, you could customize the default
asdocbook asdocbook.dcf file, and put it in Arbortext-path\
custom\doctypes\asdocbook\asdocbook.dcf to override the
built-in . dcf. Note that the document type subdirectory and file name must
be the same as the default document type name for Arbortext Editor and
Arbortext Publishing Engine to find all the relevant document type files.

A DCF file can reference other files, such as the .pcf, demo.xml, and
template.xml files. Custom versions of these files can be placed with the
.dcf in \custom\doctypes\doctype. If Arbortext Editor and
Arbortext Publishing Engine find a . dcf in the \custom\doctypes\
doctype location, relative path references are resolved by first searching the
same directory as the . dcf and then by searching the document type directory
in the original location.

The default catalog path is Arbortext-path\doctypes. If there are any
subdirectories of the custom\doctypes directory that contain a catalog
file, those subdirectories are prepended to the catalog path. Then the
custom\doctypes parent directory is prepended to the catalog path.

You can place custom tag template files (. tpl) ina custom\doctypes\
doctype\tagtemplates directory. The custom\tagtemplates
directory can also be used as a more generally available location for tag
templates.

Any document type from the custom\doctypes directory is also added to
the list of available document types that are displayed in the File » New dialog
box.

entities subdirectory
Holds file entities. Supports one level of subdirectories.

A file entity is any structurally complete document unit saved as a file. File
entities commonly have an . xm1 file extension.
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The default entity path is Arbortext-path\entities. If there are any
subdirectories of the custom\entities directory, those subdirectories are
prepended to the entity path. Then the custom\entities parent directory
is prepended to the entities path.

fonts subdirectory
Holds custom AFM or TFM font metric files (. afm and . t fm).

The default fonts path is Arbortext-path\fonts. If there are fonts in
custom\ fonts, the path is prepended. If the APTTEXFONTS environment
variable is set, the custom\ fonts directory is prepended to it.

formats subdirectory
Holds custom PubTex format files (. fmt).

The default PubTex format path is Arbortext-path\formats. If there
are . fmt files in custom\ formats, the path is prepended. If the
APTTEXFMTS environment variable is set, the custom\ formats directory
is prepended to it.

framesets subdirectory

Holds custom framesets for Publish » For Web. Supports one level of
subdirectories. Framesets are defined in the document type configuration file.

The default frameset path is Arbortext-path\framesets. If there are
any subdirectories of the custom\ framesets directory, those
subdirectories are prepended to the framesets path. Then the custom)\
framesets parent directory is prepended to the frameset path.

graphics subdirectory
Holds graphic files. Supports one level of subdirectories.

The default graphics path is Arbortext-path\graphics. If there are
any subdirectories of the custom\graphics directory, those subdirectories
are prepended to the graphics path. Then the custom\graphics parent
directory is prepended to the graphics path.

importexport subdirectory
Holds Arbortext Import/Export Import project files.

inputs subdirectory

Holds source files for custom macros, program fixes, or other customizations
ina custom. tmx. Refer to Using . tmx files for more information.
Document type and document . tmx files can be placed in the custom)\
doctypes directory.
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Also holds . tex files and source files for hyphenation exception and pattern
rules in .exc and . pat files.

The default source path is Arbortext-path\inputs. Then the
Arbortext-path\custom\inputs directory is prepended to it.

1ib subdirectory

Holds custom versions of the . pdfcf PDF configuration file. The default
path for . pdfcf filesis Arbortext—-path\1lib. Thenthe Arbortext-
path\custom\1lib directory is prepended to it. For more information on
creating . pdfcf files, refer to the Customizer's Guide.

In addition, the 1ib subdirectory can hold . wcf files for custom window
classes. For more information on creating . wcf files for window classes, refer
to the Creating custom window class preferences files in the Arbortext Editor
help.

The 1ib subdirectory can also hold custom versions of the following files:
charent.cf
charmap.cf
installprefs.acl
prted.pro
pubview.cf
pubview. fnt
tfmfont.cf
tfmscaling.cf
tfontsub.cf
wcharset.cf
wfontsub.cf
xcharset.cf
xfontsub.cf

You can specify more than one charent . cf file, as the effects are
cumulative. Refer to the Setting paths for new character set files and
APTCUSTOM environment variable topics in the online help for more
information.

The custom\ 1ib directory also has 1ocale\locale-name
subdirectories. The default path is the appropriate locale subdirectory of
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Arbortext-path\1lib\locale. The locale-specific subdirectory of the
custom\1lib\locale directory is prepended to the default locale path.

The locale\ locale—-name can hold custom versions of the . pdfcf PDF
configuration file. For more information on creating . pdfcf files, refer to the
Customizer's Guide.

Each 1ocale\ locale-name directory can hold custom versions of the
following files:

charent.cf
installprefs.acl
ixlang.cf
pubview.cf
pubview. fnt
tfmfont.cf
tfmscaling.cf
tfontsub.cf
wcharset.cf
wfontsub.cf
xcharset.cf
xfontsub.cf

The custom\1ib directory also has a subdirectory to hold native shared
libraries for platform-specific use:

© dll
Holds Windows dynamic link libraries, or DLL files (. d11).

The path to this directory is prepended to the system PATH environment
variable.

The custom\ 1ib directory can have an ix1ang subdirectory, which holds
a custom ixlang.cf file and index mapping files like those found in
Arbortext-path\lib\ixlang.

* publishingrules subdirectory

Holds publishing rules .prcf files which contain definitions of publishing
rules and publishing rule sets.

* pubview subdirectory

Holds pubview.cf and pubview. fnt files.

Custom Applications 47



48

The default path is Arbortext-path\pubview. Then the Arbortext—-
path\custom\pubview directory is prepended to it.

scripts subdirectory

Holds . acl (Arbortext Command Language), . vbs (VBScript), and . js
(JavaScript and JScript) files. Supports one level of subdirectories.

The scripts in this directory can be called from scripts or applications in the
custom\init directory, which is processed at startup time. Scripts placed
here can be accessed using the source or require ACL commands. A
customized menu item or button can call a script in custom\scripts when
invoked.

If there are any subdirectories of the custom\scripts directory, those
subdirectories are prepended to the load path. Then the custom\scripts
parent directory is prepended to the load path.

stylermodules subdirectory

Holds Arbortext Styler stylesheet modules. Any modules stored in this
directory are automatically available to Arbortext Styler.

tagtemplates subdirectory

Holds . tpl files. You can also put custom tag templates you want associated
with a particular document type into a custom\doctypes\doctype\
tagtemplates directory or in the original location of the document type's
doctype\tagtemplates directory.

If the user clicks the New button from the Tag Templates dialog box, Arbortext
Editor will use the first directory with write access for that user in the tag
template path.

If the APTTAGTPLDIR environment variable is set, this path is prepended to
it.

init subdirectory
Holds .acl, .Js, .class, and . vbs files.

The init subdirectory is processed last at startup time. All files of the
supported application types are executed. No nested subdirectories of
custom\init are supported. This directory is processed after the other
Arbortext-path\custom subdirectories so that its scripts and
applications can rely on paths already established during startup.

If you are putting custom applications on the Arbortext PE server, use the
init directory for your custom .acl, .js, .class files.
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In the startup process, the custom\init directory is processed after
~main.acl but before arbortext.wcf. See the online help topic Startup
command files for complete startup processing information.

The supported application types are:
0 .acl (Arbortext Command Language) files

Errors are reported to Arbortext Editor or recorded by Arbortext
Publishing Engine to be sent to its HTTP client.

O . js (JavaScript or JScript) files

Errors are reported to Arbortext Editor or recorded by Arbortext
Publishing Engine to be sent to its HTTP clients. You need to specify the
JavaScript interpreter engine to use in processing . j s files. Refer to
Specifying the JavaScript Interpreter Engine on page 58 for more
information.

O .class (Java) files

Java . class files in this directory must be compiled Java classes that are
not part of a named package. You can also put a .class file in custom\
init that calls into a . jar file located in the custom\classes
directory.

The Java class must also implement a public static void

main (String[] args) method, which will be called with an empty
string array. If the . class file does not implement this method, an error
is reported to Arbortext Editor or recorded by Arbortext Publishing Engine
to be sent to its HTTP client.

o .vbs (VBScript) files

Errors are reported to Arbortext Editor.
editinit subdirectory

Holds .acl, .js, .class, and . vbs files. Note that when you run
Arbortext Editor with the —c option, any applications in this subdirectory are
not executed at startup.

All files of the supported application types are executed each time a non-
ASCII document is opened for editing. Files in this directory act on a
document opened in the Edit window. File in this directory act on a document
opened using ACL when the 0x8000 flag is used with the doc_open
function. File in this directory act on a document opened using AOM when the
OPEN EDITINIT flag is used with the Application.openDocument method.

The editinit subdirectory is processed before any document type
command files, document type instance command files, and document
command files.

Custom Applications 49



The supported application types are:

O

.acl (Arbortext Command Language) files

Errors will be reported if the interface is running interactively, otherwise
they will be suppressed.

. Js (JavaScript or JScript) files

Errors will be reported if the interface is running interactively, otherwise
they will be suppressed.

.class (Java) files

Java . class files in this directory must be compiled Java classes that are
not part of a named package. The Java class must also implement a
public staticvoidmain (String[] args) method, which is
called with an empty string array. You can puta .class file in custom)\
init thatcalls into a . jar file located in the custom\classes
directory. Errors will be reported if the interface is running interactively,
otherwise they will be suppressed.

.vbs (VBScript) files

Errors will be reported if the interface is running interactively, otherwise
they will be suppressed.

Error Reporting for the custom\init Directory

Errors caused by mistakes in custom code in the Arbortext-path\custom\
init directory are reported with both the error message and the name of the
initialization file causing the error. Note the following:

If Arbortext Editor is not running interactively (batch mode), no errors are
reported and the errors are not logged.

Arbortext Publishing Engine records errors and reports them to its HTTP
clients in an HTML error page.

ACL, JavaScript, and Java class errors are reported to the Arbortext Editor
interface or held by Arbortext Publishing Engine to be sent to HTTP clients
making requests.

Additional Information

If you are using the AOM, refer to the documentation for
Application.getCustomDirectory. Refer to the XUI section of the
Customizer's Guide for information on extending the Arbortext Editor Preferences
dialog box for your custom application.
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The following set command options and environment variables affect custom
path search lists. They are documented in the online help.

set catalogpath
set composerpath
set dialogspath
set ditapath

set entitypath
set framesetpath
set graphicspath
set javaclasspath
set libpath

set loadpath

set pdfconfigfile
set tagtemplatepath

set userdictpath

Using the Custom Directory for Custom
Applications

The Arbortext-path\custom subdirectory structure provides the means to
implement custom applications. Where your application should be placed depends
on the application purpose and programming language.

If you're implementing custom applications or scripts, the following information
will assist you in determining the approach and location for your files:

* A custom Java program can be placed in custom\init, which supports a
.class file that must implement a public static voidmain
(String[] args) method. The method will be called at startup with no
arguments (an empty St ring array). If an error occurs, it's reported
interactively for Arbortext Editor or sent to the HTTP client for the Arbortext
Publishing Engine.

A custom Java program can also be placed in custom\classes, which
supports .class or . jar files.

We recommend putting Java applications in the custom\classes directory
and calling or initializing them from the custom\init directory.
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Paths to . jar files in custom\classes are automatically prepended to the
embedded Arbortext Editor Java class path. Then the path to custom\
classes is prepended, putting it first in the search order.

* A custom JavaScript, JScript, VBScript, or ACL application can be placed in
custom\init orin custom\scripts. If you place your scripts in the
custom\scripts directory, you can call them from a script or scripts you
place in custom\init (which is processed at startup). Any code that exists
outside a function definition in a script from custom\init is executed at
startup time. Errors are reported if running interactively, otherwise they're
suppressed.

You can create a simple JavaScript example file called simple init.js. The
script should contain the following line:
Application.alert ("Hello from JavaScript");

Put the simple init.js filein Arbortext-path\custom\init.

When the startup process loads scripts from custom\init, you will see a dialog
box showing the Hello from JavaScript message.

Description of the Application Directory
Structure

The Arbortext-path\application subdirectory supports installing an
application into the Arbortext Editor and Arbortext Publishing Engine install
trees. Arbortext Editor and the Arbortext Publishing Engine automatically search
for subdirectories of the application directory at startup.

Arbortext-path\application must contain a uniquely named
subdirectory for each distributed application. Arbortext recommends using the
naming pattern for a unique qualified Java class name:
com.company-name.application-name

Each unique subdirectory of the application directory must also contain an
application.xml configuration file which describes various aspects of the
application, such as its release version and supported versions of Arbortext
products. At startup, Arbortext Editor and the Arbortext Publishing Engine search
the application directory for any subdirectories containing an
application.xml configuration file. The application.xml file contents
provide the criteria to determine whether the application should be loaded. The
application directory must be located using a file system; HTTP references
are not supported.
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Subdirectory Structure

A subdirectory of the application directory can be structured the same as the
custom directory to take advantage of automatic Arbortext Editor and Arbortext
Publishing Engine startup processes. For example, if the uniquely named directory
contains graphics or entities directories, those directories are
automatically added to the search paths constructed at startup.

An application path could be something like:
application\com.company-name.application-name

Refer to the Description of the custom directory structure on page 41 for the
names and descriptions of each supported subdirectory.

~ Note

When Arbortext Editor or the Arbortext Publishing Engine constructs search
paths, subdirectories of the custom directory take precedence over any
corresponding subdirectories under the application directory. When
search lists are constructed at startup, the first path in any search list will be
the appropriate custom directory followed by any applicable directory under
the application directory. For example, in constructing the graphics
search path list at startup, custom\graphics would precede
application\com.arbortext.sample\graphics. An
application\graphics directory withno application.xml file
will be ignored during startup.

When implementing a custom application using the application directory
structure, you can add supplemental directories as needed to support your
application. However, your application code must be aware of these directories
and how to use them.

Application Startup File

The Arbortext-path\doctypes\appcfgl\application.xml file
provides a basic template for defining information about the custom application.
You can make a copy of doctypes\appcfgl\application.xml touse as a
template to create the file that will eventually be distributed with the application.
The application.xml file must be placed in the application's top level

directory, for example:
Arbortext-path\application\com.company.application-package-name
\application.xml

In the template application.xml file, you can specify a list of elements that
describe the application. If the custom application determines its criteria is not met
and the application is not to be loaded, then these values are ignored. The base
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element for the file is the ApplicationConfiguration element. This
element has a required attribute called installType that determines the type of
Arbortext Editor installation for which this application is supported. The
supported value is full meaning the application is only supported in the full
installation of Arbortext Editor. The value any previously indicated whether
compact installation of Arbortext Editor was supported

The following other elements are supported in the application.xml file:
* Name (required)

* Description

* LicenseNumber is only for an application distributed by Arbortext

* Version (required)

e Date

* Copyright

* Vendor

* RequiredApplications is for other applications that are required for
this application to run correctly. You must enter the qualified name for the
application in the qualifiedName attribute and a human-readable name in the
name attribute.

* SupportedProducts

A Product element has attributes for specifying the name (required),
minimum version (required), and maximum version of the Arbortext product
that supports the custom application or application. The Product
specification helps the launching Arbortext product determine whether it
should load this custom application by matching criteria specified in this
section.

The name must be one or more of the following:

O  Arbortext Editor

O Arbortext Publishing Engine
O Arbortext Architect

O Arbortext Editor with Styler

The version must follow the convention used by Arbortext products, such as
5.2,5.2 M040, or 5.3.

* SupportedPlatforms

The section is reserved for future use. Windows is currently the only supported
platform.

* GlobalParameters
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Parameter contains ParameterName and ParameterValue elements
for specifying any global variables that the application may need when it's
launched.

Related Topics

If you are using ACL, refer to the following ACL function descriptions:

* application name function

* get custom dir function

* get custom property function
* get user property function

* set user property function

If you are using the AOM, refer to the documentation for
Application.getCustomDirectory. Refer to the XUI section of the
Customizer's Guide for information on extending the Arbortext Editor Preferences
dialog box for your custom application.

The following attributes from the Application interface are also useful:

* haveWindows

* 1initDone

e 1isE3

* customProperties
* userProperties

° name

Using the Application Directory for
Custom Applications

The Arbortext-path\application subdirectory provides the means to
implement a custom application that uses a special configuration file to determine
whether it should be loaded at startup. The application directory uses the
same principles of structure as the custom directory.

The Arbortext-path\application directory is processed at startup. If
you add a custom application after startup, you must exit and restart Arbortext
Editor or stop and restart the Arbortext Publishing Engine to have it recognized.
You also have the option to issue the f=1nit function to re-initialize the
Arbortext PE sub-processes. Refer to Configuration Guide for Arbortext
Publishing Engine for more information.

Rules for using the application directory are:
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Your custom application must be contained in a uniquely named subdirectory
of the application directory.

You must have an application.xml configuration file in the uniquely
named subdirectory that sets the conditions for loading the application.

The same set of subdirectories supported by the custom directory are
supported for the uniquely named subdirectory of the application
directory. At startup, the supported directories are automatically detected and
used in constructing search paths.

Any other subdirectory of the application directory will be ignored at
startup. For example, an application\graphics subdirectory with no
application.xml file will be ignored during startup.

Arbortext has developed proprietary custom applications that are deployed using
the application subdirectory structure. A uniquely named subdirectory
contains all the necessary components to run an application within Arbortext
Editor as well as the Arbortext Publishing Engine.

The following information will help determine an approach for a custom
application.
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You can have additional subdirectories for your custom application. You are
not limited to the subdirectories supported by the custom directory.
However, these additional directories are not automatically recognized during
the startup process.

Processing each unique application's subdirectories follows the same rules for
processing custom subdirectories. Recall that the application's subdirectories
come after the custom subdirectories in constructing any applicable search
paths for the session.

If you decide not to use a particular supported subdirectory, you can improve
performance by omitting the directory to reduce the length of a search path
that would contain it.

You can use the APTAPPLICATION environment variable to set the path to
one or more application directories.

An application should not write data to its own application directory. An
application user may not have write permission access to this application
directory, for example, any C: \Program Files directories on Windows
(the location where Arbortext Editor and the Arbortext Publishing Engine are
typically installed).
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Deploying Zipped Customizations

You can deploy not only custom directories, but also application and
content management system adapters directories in a compressed zip file. Using a
zip file to distribute your customizations has the following advantages:

You can host your customizations on a web server.

In this case, use the HTTP or HTTPS URL to the zip file as the value for the
APTCUSTOM environment variable.

Your customizations will be available to users when they cannot access your
network.

If you use a shared network folder to host your customizations, users do not
have access to those customizations when the network is unavailable. If you
use a zip file to distribute your customizations, Arbortext Editor unzips those
customizations to a directory in the Arbortext Editor cache directory
(.aptcache\zc). At start up, Arbortext Editor checks to see whether the
zip file has been updated. If it has, Arbortext Editor downloads and
uncompresses the updated customizations. If not, Arbortext Editor continues
to use the customizations stored in the local cache. If the network is
unavailable to a user, your customizations are still available to that user in the
local cache. Note that the user must also have a fixed Arbortext Editor license
on their system to work away from the network.

Network traffic might be reduced.

Since the zip file containing your customizations is only downloaded once
over the network, and then only if it has been updated, traffic on your network
might be reduced. If you store your unzipped customizations in a shared
network folder, Arbortext Editor might have to access that folder several times
over the course of a session.

Customizations stored in a compressed zip file are harder to change
accidentally than customizations stored in a directory structure.

Note that you cannot use a zip file to distribute a customized
installprefs.acl inthe custom\1lib directory. You can use the
APTINSTALLPREFS environment variable to specify the location of a custom
installprefs.acl file.

Note also that you cannot include the following font configuration files in the 1ib
subdirectory of a zipped custom directory:

charent.cft
wcharent.cft
wfontsub.cft

charmap.cft
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These files are processed before a zipped custom directory when Arbortext
Editor starts up, so the files cannot be processed when deployed in that way.

Specifying the JavaScript Interpreter
Engine

Both JavaScript and JScript files have a . j s file extension. By default, Arbortext
Editor and the Arbortext Publishing Engine interpret . j s files as Rhino
JavaScript files. You should specify the JavaScript interpreter for a JavaScript or
JScript . js file. This is especially important if you have . js files of both types.

We recommend adding a comment line to your script that specifies either the
Rhino JavaScript engine (the default) or the Microsoft JScript engine as shown in
the following examples. The first line of your . js file must be a comment
starting with / /.

To specify the Rhino JavaScript interpreter:
// type="text/javascript"

To specify the Microsoft JScript interpreter:
// type="application/jscript"

The specification can be enclosed in a script tag. Both of the following examples
are a valid specification for JScript:

// <script type="application/jscript">

// type="application/jscript"

You can also specify the JavaScript interpreter using the ACL set
javascriptinterpreter command. You can specify it in an ACL file
placed in the Arbortext-path\custom\init directory, where it will be
processed at startup. For information on setting the interpreter using ACL, see the
online help topic for set javascriptinterpreter.
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Using ACL with the AOM

USIiNG the ACIH INTEIMACE ... .cieeei e 62

You can access the Arbortext Object Model (AOM) from the Arbortext Command
Language (ACL). Because the AOM does not currently provide all the
functionality available from ACL, an AOM program may need to call ACL
functions for certain types of customizations. There are several ACL functions
that interface with Java, JavaScript, JScript, VBScript, and COM, which are
documented in the Arbortext Command Language Reference. Each section in this
guide that covers a specific programming or scripting language notes any
language-specific binding issues.
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Using the Acl Interface

The AOM provides the Acl interface with methods to evaluate an ACL expression
(Acl.eval) or execute an ACL command (Acl.execute). Both methods take
a string object as an argument. This means that any AOM object passed to ACL
must be converted to a string. Likewise, an ACL type returned by Acl.eval is
converted to a string to pass to the AOM.

The expression passed to Acl.eval and the command passed to
Acl.execute are evaluated in the ACL package context of the originating ACL
function that invoked the AOM method, for example, javascript or js
source for JavaScript or a java type function for Java. For document type
and document JavaScript and VBScript customization files automatically executed
by Arbortext Editor or the Arbortext PE sub-process, this is the main package. If
the string passed to Acl.eval or Acl.execute starts with a function call with
a package prefix, then the package declaring the function is used.

~ Note

Be aware that the letter case to use for the Acl interface methods varies
depending on the implementation language being used. If you are working
with Java or Javascript to implement the Acl interface, refer to the Acl class
Javadoc in the Arbortext Editor Help Center for the proper letter case for the
Acl methods.
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Java Interface Overview

Arbortext Editor and Arbortext Publishing Engine include a Java binding to the
AOM. Using this binding, software developers can use the Java programming
language to write applications for Arbortext Editor or the Arbortext Publishing
Engine.

Arbortext Editor and the Arbortext Publishing Engine implement the Java
interface using the Java Native Interface (JNI). The JNI allows Java code that runs
within an embedded Java Virtual Machine (JVM) to operate with applications and
libraries written in other languages such as C++. In Arbortext Editor and the
Arbortext Publishing Engine, the JNI interacts specifically with the AOM.

Arbortext Editor or an Arbortext PE sub-process creates only one instance of the
JVM per session and initializes it the first time a Java method is executed. The

-7 s startup option may be specified when launching Arbortext Editor to cause the
JVM to be initialized on startup. You can also start the JVM using the java
init ACL function. The JVM is unloaded when you end the current Arbortext
Editor or Arbortext PE sub-process session.

There are several ACL functions of the form java xxx that allow ACL
programs to call a Java static method, a Java instance method, or a Java
constructor, and otherwise interact with Java programs. These ACL functions are
explained in Java and ACL on page 64.

Java Interface Platform Requirements

The Java interface requires access to Oracle’s Java Runtime Environment (JRE),
which is included in the Arbortext Editor or Arbortext Publishing Engine
installation in the Arbortext-path\bin\jre directory.

Refer to the Installation Guide for Arbortext Editor, Arbortext Styler, and
Arbortext Architect or Installation Guide for Arbortext Publishing Engine for the
most recent version support information.

To use a specific JVM, you need to specify it with the Javavmpath ACL set
option. To set the maximum size of the Java Virtual Machine (JVM) memory
allocation pool, use the APTJAVAVMMEMORY environment variable (sets the
size of JVM on startup of Arbortext Editor) or the javavmmemory ACL set
option.

Java and ACL

To call a Java method from ACL, use one of the following java type
functions.

* Jjava_constructor — Calls a Java constructor.

* Jjava constructor modal — Calls a Java constructor in a new thread.
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* java delete — Deletes a Java object created by java constructor,
java instance,or java static.

* Jjava instance — Calls a Java instance method.

* Jjava_instance modal — Calls a Java instance method in a new thread.
* java static — Calls a Java static method.

* Jjava static modal — Calls a Java static method in a new thread.

* Jjava_init — Tests if the JVM is running and optionally initializes it.

The flow of control in the Java interface usually starts with the execution of a
java type ACL function.Arbortext Editor or the Arbortext PE sub-process
starts its embedded Java Virtual Machine (JVM) at startup, making the distributed
Java classes and user Java classes available. Java . class files placed in the
custom\init directory are automatically executed without the need for the
java_type functions.

The Java programming language supports method overloading, so several
methods in a class may have the same name with different arguments. When
searching for the method to invoke, Arbortext Editor or the Arbortext PE sub-
process will use the first method it finds that has the correct name and correct
number of arguments.

The java type functions use Java reflection methods to analyze the called Java
class or method before calling it, converting the arguments in the java type
function to the data types used by the called Java code. If you include ACL
variables and function calls within your arguments, Arbortext Editor or the
Arbortext PE sub-process will perform the necessary variable substitution and
pass the result to the called Java code. All arguments passed are considered read-
only to the called Java code; the called Java code will not change the value of any
of the passed arguments.

Argument values that originate in ACL and are passed to a class or method can
only be converted to a void, a Java string, or one of the supported primitive data
type. The supported primitive data types are:

s int

* short

* long

+ float

* double
* char

* byte

Argument values that originate as returned data from a previous call to a java
type function can be passed back to a Java class or method. For example, a
called Java method may return a Java structure. This returned object would be
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placed within the specified ACL return variable name. While this Java structure
could not be used directly within ACL, you could pass it to another Java class or
method by calling a java type function and supplying the return variable name
as an input argument.

Passing Arrays Between Java and ACL

Some ACL functions accept or return array data. Java programs that call these
ACL functions will require additional coding to transfer the array data across the
interface.

For example, if a Java program needs a list of the available tag names in a
document, it can use the Acl.eval Java method to call the tag names ACL
function. This ACL function returns an integer for the total number of available
tag names to the Java method, but it stores the array of tag names in an ACL array.
To retrieve this data and make it available to the Java program, further calls to the
Acl.eval method would be necessary. Consider the sample code that follows:
// This method fills a Java String array with the data
// from an ACL array
private String[] convertAclArray(String aclArrayName, \

int aclArraySize) {

String[] result = new Stringl[aclArraySize];

for (int i = 0; 1 < aclArraySize; i++) {

// The first element of a Java array has index 0 but the first
// element of an ACL array has index 1

result[i] = Acl.eval (aclArrayName + "[" + String.valueOf (i+1)
+ "1

}

return result;

}

try {

total = Acl.eval("tag_names($arr)");

} catch (AclException e) {

// Maybe the $arr has been defined and it is not an array

g.drawString (e.getMessage () , 20, 60);

return;

}

String[] names = convertAclArray("$arr", Integer.parselnt (total));

Similarly, data in Java arrays need to be transferred to an ACL array before that
data can be used by an ACL function.
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The java array from acland java array to acl ACL functions
can also be used to convert certain types of arrays between ACL and Java. See the
online help for details.

Java Virtual Machine (JVM) Management

By default at startup, Arbortext Editor detects and loads an installed Java Virtual
Machine (JVM). You can also load the detected JVM using the java init
function. The JVM instance is dedicated to running Java code started from within
Arbortext Editor. Arbortext Editor creates only one instance of the JVM per
session. The JVM is unloaded when you end the current Arbortext Editor session.

You can use the set javavmmemory ACL command to set the maximum size
of the memory allocation pool before the JVM starts.

~ Note

If APTJAVAVMMEMORY has a value, all subsequent set javavmmemory
commands are ignored.

You can see the current JVM version by choosing Tools » Administrative Tools >
Java Console to open the Arbortext Java Console.

Making Classes Available to the Embedded JVM

The simplest way to make your classes available to Arbortext's embedded JVM is
to put them in the custom\classes directory. Any .class and . jar files in
Arbortext-path\custom\classes are automatically added to the
Arbortext Editor class path.

You can also use the ACL set javaclasspath command or the ACL
append javaclass path function to set the list of directories where the
embedded JVM can locate your Java classes. The default setting of set
javaclasspath includes Arbortext-path\custom\classes.

The javaclasspath option is used only for locating non-Arbortext supplied
classes. In addition to aom. jar, several other . jar files are distributed in
Arbortext-path\lib\classes and are automatically included as part of
the embedded JVM's class path.

Once the JVM has started, changes to the javaclasspath option or to the
directories it specifies will not take effect until you exit and start a new session of
Arbortext Editor or stop and restart the servlet container for the Arbortext
Publishing Engine.
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Making the AOM Available for Other Java Programs

If you are compiling a Java program that uses the AOM, put Arbortext-
path\lib\classes\aom. jar in the compiler's ~classpath argument.

Accessing the Java Console

The Java Console displays everything that a Java program writes to the Java
System.out PrintStream and output from the JavaScript Print () function.
The Java Console also displays the JVM version number and vendor.

~ Note

The Java Console is not a standard input (that is, stdin). You cannot type in
the Java Console window.

For example, if you use the java static function to run a Java method and
that Java method executes:

System.out.println ("Hello");
then He11o displays on the Java Console (if the Java Console is open).

If the Java Console is closed, output will be discarded.
There are two ways in which you can access the Java Console:

* Choose Tools » Administrative Tools » Java Console.

* Usethe java console function. You can also use this function to
specify the size of the window.

AOM Packages

Arbortext Editor and the Arbortext Publishing Engine ship with Java classes for
using the AOM from the Java programming language. The supplied Java classes
are stored in a Java archive file Arbortext-path\lib\classes\aom. jar
and are intended for developer use. The AOM and DOM Java classes and
interfaces are stored in the following packages:

Package Description

com.arbortext.epic The core interfaces of the AOM,

including the singleton Application and
Acl objects.

com.arbortext.epic.table The table-related interfaces for the
AOM, including the TableObject
superinterface.
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Package Description

com.arbortext.epic.ui User interface-related interfaces for the
AOM, including the Component
superinterface.

org.w3c.dom The core interfaces for the W3C
Document Object Model (DOM).

org.w3c.dom.events The interfaces for the W3C DOM
Events specification.

org.w3c.dom.ranges The interfaces for the W3C DOM
Ranges specification.

org.w3c.dom.views The interfaces for the W3C DOM

Views specification.

All the methods in the Application class and the Acl class are class methods.
Therefore you will never need an instance of the Application or an Acl object.

~! Note

If you inspect the aom. jar file, you will find additional packages (for
example, com.arbortext.epic.internal). These additional packages are for
Arbortext internal use and should not be used in your Java programs.

Your Java program should import the required AOM and DOM packages. For
example, if you are writing a DOM event handler you would need to import at
least the following packages:

import com.arbortext.epic.*;

import org.w3c.dom.*;

import org.w3c.dom.events.*;

See Overview on page 120 for details on using events with the AOM.

~! Note

The com.arbortext.epic.ui package defines several AOM-specific interfaces
that have the same names as some in the java.awt package. If you import
the AOM user interface package in a . java source file, do not also import
java.awt.
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Javadoc

Complete Java API Javadoc is delivered in the Programming » Javadoc section of
Help Center. You can also refer to the detailed documentation for each of the
AOM interfaces in Interface Overview on page 185.

Compiling Your AOM Java Program

When compiling a Java program that uses the AOM, you must put Arbortext-
path\lib\classes\aom. jar in the compiler's ~classpath argument.

For example:
javac -classpath "C:\Program Files\Arbortext\editor\lib\classes
\aom.jar" MyClass.java

The compiled program can only be run within Arbortext’s Java environment. Java
programs running in a JVM outside of Arbortext Editor cannot use the AOM
classes.

Using an IDE to create Your AOM Java
Program

There are a number of Java-based Integrated Development Environments (IDE)
that can be used to create AOM Java programs. The IDE must be able to find the
AOM JAR file. Using Oracle's J/Developer version 3.2.2 as an example, follows
these instructions:

1. Create a library

Click on menu item Project followed by Project Properties. On the resulting
dialog box, choose the Libraries tab and then click the Libraries button. On the
resulting dialog box, click the New button and name the new library
Arbortext AOM. In the Class path field on the same dialog box, specify
Arbortext-path\lib\classes\aom. jar. Click OK to finish creating
the library.

2. Reference the library

Return to the Project Properties window under the Libraries tab and click the
Add button. Select Arbortext AOM on the resulting dialog box and click OK
to add it to the current project.

Refer to the documentation for your IDE for instructions on a class path.
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Making Classes Available to the
Embedded JVM

You can use the set javaclasspath command or the append

javaclass path function to set the list of directories where the embedded
JVM can locate your Java classes. The default setting of set javaclasspath
is empty. Regardless of whether set javaclasspath is set, the embedded
JVM searches the distributed Java classes in Arbortext-path\1ib\
classes\aom. jar. The aom. jar file holds com.arbortext.epic,
which contains the Arbortext Editor distributed Java classes that implement the
AOM and DOM.

Any .class and . jar filesin Arbortext-path\custom\classes are
automatically added to the Arbortext Editor class path.

Subsequent changes to specify external Java class directories do not affect the
running JVM until you exit Arbortext Editor and start a new session. Be sure to
set the path to your directory before making your first Java function call.

Java Access to DOM Extensions

The AOM's extensions to DOM are represented by companion interfaces that start
with the letter A, for example, ANode is the extension to the W3C Node interface,
ADocument is the extension to the Document interface, and so on.

In Java, these interfaces can be obtained from their related objects by using the
casting methods. For instance:

Document doc = Application.getActiveDocument () ;

Range r = ((ADocument)doc) .getInsertionPoint();

Java Interface Exceptions

Several AOM and DOM methods will raise an exception if an error occurs. The
following tables summarize the DOM and AOM exception classes:

DOM Exception Classes

Exception Class Description
DOMException Raised by core DOM methods.
EventException Raised by DOM event methods.
RangeException Raised by DOM range methods.
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AOM Exception Classes

Exception Class Description

AclException Raised by methods in the Acl interface.

AOMException Raised by general AOM methods.

TableException Raised by table-related methods.

WindowException Raised by Window and other user interface related
methods.

In the Arbortext Editor Java interface, all DOM and AOM exceptions are
subclasses of java.lang.RuntimeException and inherit the
getMessage method from the java.lang.Throwable interface. The
getMessage method can be used to retrieve an error message associated with
the exception.

Most DOM and AOM exception classes define a code field that can be accessed
to determine the numeric error code associated with the exception (the exception
is the AOMException class). Symbolic names for the error codes listed with
each exception interface description in Interface Overview on page 185 are
available as class constants. For example, the following checks for a specific
:DOhdeﬂoraxh(NO_MODIFICATION_ALLOWED_ERR)

try {

node.insertBefore (newNode, refNode) ;

}

catch (DOMException e) {

if (e.code == DOMEXCeption.NO_MODIFICATION_Z—\LLOWED_ERR) {
// document is read only

}

}

If your Java program does not catch an exception, its execution will be aborted
and an error message will be displayed.

Accessing the Java Console

The Java Console displays everything that a Java program writes to the Java
System.out PrintStream and output from the JavaScript print () function.
The Java Console also displays the JVM version number and vendor.

~ Note

The Java Console is not a standard input (that is, stdin). You cannot type in
the Java Console window.
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For example, if a Java method executes:
System.out.println ("Hello");

then He11o displays on the Java Console (if it is open).
If the Java Console is closed, output will be discarded.
There are two ways you can access the Java Console:

* Choose Tools » Java Console.

» Usethe java console ACL function, which can also specify the size of
the window.

Debugging Java Applications

Arbortext Publishing Engine requires you to obtain a JRE from Oracle (www.java.
com) and install it. Arbortext supports the Java Platform Debugger Architecture
(JPDA, see http://java.sun.com/products/jpda/),any JPDA compliant Java
debugger can hook into Arbortext.

JDB can also be used to debug a Java program using two methods: the socket
method and the shared memory method.

Before using JDB, ensure you have Oracle JDK version 11 or later installed on
your workstation. Java debugging related DLLs and shared libraries must be
accessible by the debugger. The PATH environment variable must include the bin
directory of the JDK.

Compile your Java programs with the —g flag (for debugging).

The Socket Method

The ACL set javadebugport option specifies the socket port you want to
use for debugging. If javadebugport is set to auto, the Arbortext Publishing
Engine and Arbortext Editor will randomly select an unused socket port.

As an example, if you want to debug the EventF1low class, and it is located in
the directory C: \ temp, use the following steps.

1. From the Arbortext Editor command line, enter the following commands:
set javaclasspath=C:\temp
set javadebugport=auto
java console() # this loads the JVM
eval option ('javadebugport')

Note the port number displayed in the eval window. For purposes of this
example, assume this number was 3539,

2. Open a shell window, navigate to the directory where your Java source resides,

and enter the following command:
jdb -connect com.sun.jdi.SocketAttach:port=3539
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3.

After JDB is initialized, give it a break point. For example, to break at the
method f1ow of the class EventF1ow, enter the following:
> stop in EventFlow.flow

From the Arbortext Editor command line, run EventFlow. f1low as follows:
java_static('EventFlow', "flow')

JDB will stop at the break point and display the line of the source code where
it stopped.

The Shared Memory Method

To use the shared memory method, you must set JVM arguments properly and
create a name for the shared memory address.

As an example, if you want to name the shared memory address <myaddr>, use
the following steps to debug EventFlow.class in C: \temp:

1.

From the Arbortext Editor command line, enter the following commands:
set javaclasspath=C:\temp

set javavmargs="-Xdebug -Xrunjdwp:transport=dt shmem,
address=<myaddr>, server=y, suspend=n"

# the above is one long line

java console ()

Open an MSDOS shell and enter the following command:

jdb -attach <myaddr>

After JDB is initialized, give it a break point. For example, to break at the
method £1ow of the class EventF1ow, enter the following:

> stop in EventFlow.flow

From the Arbortext Editor command line, run EventFlow. f1low as follows:
java_ static('EventFlow', 'flow')

JDB will stop at the break point and display the line of the source code where
it stopped.

Sample Java Code

Sample Java code for the Java interface is included in the Arbortext-path\
samples\java directory. The README file in this directory provides a
description of the sample code and how to invoke the sample methods. Note that
you must compile the sample Java code before you can use it.
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JavaScript Interface Overview

Arbortext Editor and the Arbortext Publishing Engine include a JavaScript
binding to the AOM. Using this binding, software developers can use the
JavaScript programming language to write applications for Arbortext Editor and
the Arbortext Publishing Engine.

Arbortext uses the Rhino open-source Java implementation from The Mozilla
Organization as its JavaScript interpreter. This version of Rhino supports the
JavaScript language version 1.5 and is compliant with the European Computer
Manufacturers Association (ECMA) standard described in ECMA-262 Edition 3
(www.mozilla.org/js/language/E262-3.pdf).

Arbortext Editor uses the Rhino interpreter unmodified, distributed as
Arbortext-path\lib\classes\js.jar. For more information about
Rhino, see the Rhino: JavaScript for Java web page at http://
mozilla.github.io/rhino/. The source code for the interpreter is
available at the Mozilla site at http://mozilla.github.io/rhino/.

The Arbortext Object Model (AOM) interface for JavaScript is implemented on
top of the Java AOM interface classes using a feature called LiveConnect. Refer
to Calling Java from JavaScript on page 84 for details.

~ Note

The Arbortext Editor JavaScript implementation supports the DOM and
Arbortext Editor AOM interfaces only. It does not support client-side
JavaScript found in web browsers. In particular, there is no browser Window
object or window global execution context. The AOM provides its own
Window interface. By default, all JavaScript code is executed in a single global
context. Arbortext Editor does not currently support other browser-specific
JavaScript objects such as Form, HTMLE lement, or Location.

JavaScript platforms

The JavaScript interface is implemented in Java, so it has the same platform
requirements as the Java interface. Refer to Java Interface Platform Requirements
on page 64 for more information.

JavaScript and ACL

JavaScript expressions or scripts can be called from ACL with one of the
following ACL primitives:
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* Jjavascript — Function that evaluates a JavaScript expression and returns
the result as a string.

* Jjs_source — Function that reads and executes a file containing a
JavaScript program.

* Jjs — Command that evaluates a JavaScript expression and displays the
result.

* source — Command that interprets files ending in . js as JavaScript
programs to be executed when set javascriptinterpreter issetto
rhino.

The flow of control in the JavaScript interface usually starts with the execution of
one of these ACL functions or commands, with the exception of customization
files ending in . js. Arbortext Editor and the Arbortext PE sub-process
automatically load and execute JavaScript programs from the doctype. js,
instance.js, and document. js files following the same rules as
doctype.acl, instance.acl, and docname.ac] files.

The JavaScript interpreter starts the first time Arbortext Editor or the Arbortext PE
sub-process executes one of these ACL functions or commands or reads a . J s
customization file. Arbortext Editor and the Arbortext PE sub-process will also
start the Java Virtual Machine, if necessary. You may also specify the - s startup
command option to start JavaScript when Arbortext Editor is opened.

Unlike the Java interface, only string arguments are passed from ACL to
JavaScript. So any ACL argument value passed to js_source is converted to a
string. ACL arrays must be converted to some form of delimited string (for
example, as an array literal) or passed element by element to JavaScript
expressions. Refer to Passing Arrays Between JavaScript and ACL on page 77 for
more details.

JavaScript objects may not be returned directly to ACL. If the result of a
JavaScript expression passed to javascript is an object, the toString
method is invoked on the object and that value is returned by javascript.

Passing Arrays Between JavaScript and ACL

There are two ways to pass arrays between JavaScript and ACL, both involving
the conversion of arrays to strings. The first method uses the JavaScript Array.join
method to convert the JavaScript array to a string that is passed to the ACL
split function.

For example, the JavaScript code

var jsArr = [1, 2, 3];
Acl.eval ("split ('™ + jsArr.join() + "', aclArr, ',")");

converts the JavaScript array jsArr to the ACL array aclArr.
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~ Note

ACL arrays normally start at index 1, which is the same as JavaScript index 0.

The second method uses a loop to pass the array, element by element. The Acl.eval
call in the example above can be rewritten as:

for (var i = 0; i < jsArr.length; i++) {
var ai =1 + 1;
Acl.eval ("aclArr[" + ai + "] = '"" + JsArr[i] + "'");

}
This method is slower, but isn't subject to the ACL string token limit of 4096
characters.

Similarly, there are two ways to retrieve an ACL array from JavaScript. The first
method uses the ACL join function to concatenate the ACL array into a string
that initializes a JavaScript array. For example, you can use the following ACL
code to pass the ACL array created above to JavaScript:

javascript ("var jsArr = [" . join(aclArr) . "1");

This method is not limited by the ACL string token limit.

You can also use a loop to retrieve the array, element by element, as shown in the
following JavaScript example:

var count = parselnt (Acl.eval ("count (aclArr)"));

var lowBound = parselnt (Acl.eval ("low bound(aclArr)"));

var jsArr = new Array (count);

for (var i = 0; 1 < count; i++) {

var ali = lowBound + i;

jsArr[i] = Acl.eval ("aclArr[" + ai + "]1");

}

This method translates the arbitrary array index bounds in an ACL array to the
zero-based array index in JavaScript. It also uses the parselnt method to convert
the Java string returned by Acl.eval into a JavaScript number.

Associative Arrays

The previous examples concern normal numeric indexed arrays. You can use
equivalent techniques to pass associative arrays using for/in loops instead of
the for loops as above. The following JavaScript example passes an associative

array to ACL:

var jsAssoc = {one: 1, two: 2, three: 3};

for (var i1 in jsAssoc) {

Acl.eval ("aclAssoc['"™ + 1 + "']="'"" 4+ JsAssoc[i] + "'");

}
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You can pass an ACL associative array to JavaScript using the ACL join
function or an ACL for/in loop similar to the JavaScript example. The
following ACL example shows the join technique to declare a JavaScript array
using object literal syntax:

javascript ("var jsAssoc={" . join(aclAssoc,',',1) . "}")

~ Note

The ACL join function also works for associative arrays, and produces a
result that can be used to initialize a JavaScript associative array object as in
the previous example.

JavaScript Limitations

The following lists some limitations of the Arbortext Editor JavaScript
implementation.

» The Mozilla Rhino JavaScript interpreter does not support the

netscape.javascript.JSObject class as part of LiveConnect. It uses

a different mechanism for accessing JavaScript objects from Java. See
Requirements and Limitations at the Mozilla web page
developer.mozilla.org/en-US/docs/Web for additional
limitations of the interpreter, and the Mozilla web page
developer.mozilla.org/en-US/docs/Web/Tutorials fora
description of using JavaScript objects from Java.

»  Strings returned by AOM/DOM methods are Java St ring objects and not
JavaScript St ring objects. While Java St ring objects share many of the
same methods as JavaScript String objects (for example, charAt,
substring, toLowerCase) and can be used in string contexts, they are

not equivalent. In particular, Java St ring has no 1ength property; use the

length () method instead. Also, Java St ring is not automatically

converted to a number when used in a numeric context. To explicitly convert a

Java String to a number when appropriate, use the parseInt or
parseFloat function.

To perform JavaScript-style string manipulations on a Java St ring returned

by the AOM, convert the string to a JavaScript St ring by concatenating it

with a null string. For example:
var jsStr = doc.documentElement.tagName + "";
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JavaScript Language Extensions

The Arbortext Editor JavaScript implementation includes a few non-standard
extensions, modeled on similar features provided by the Rhino Shell. The Rhino
Shell is a standalone utility from Mozilla that runs JavaScript programs.

Function
defineClass (javaclass)

implementationVersion ()

importClass (javaclass)

importPackage (javapackage)

80

Description

This global function defines a
JavaScript class from the Java class
specified by javaclass. The Java
class file must be in the class path set
for the Java Virtual Machine embedded
in Arbortext Editor, for example, by
including the . class file in the
Arbortext-path\custom\
classes directory.

javaclass must implement the org.
mozilla.javascript.Scriptable interface or
extend the org.mozilla.javascript.
ScriptableObject class. See the Rhino
documentation at the Mozilla web page
for details.

This global function returns the
JavaScript interpreter implementation
version as a string encoding the product
name, language version, release
number, and date.

This global function will “import” the
Java class javaclass by making its
unqualified name available as a
property of the top-level scope.

This global function will “import” all
the classes of the Java package
Jjavapackage by searching for
unqualified names as classes qualified
by the given package. This is similar to
the Java import statement.
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Function

load(filename, ...)
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Description

~ Note

If this function is evaluated in the
global scope, then the unqualified
names are available to all
JavaScript code subsequently
executed in the shared scope.

This global function will load and
execute the JavaScript source file given
by the filename argument. Multiple file
name arguments may be specified and
filename can be a URL.

If filename is not an absolute path or
URL, the list of directories is the list in
loadpath parameter of the setOption
method, described in AOM set Options
Overview on page 737.

If filename is not found relative to the
current directory and is not an absolute
path, the list of directories specified in
the Arbortext Editor (or the Arbortext
Publishing Engine) loadpath parameter
is searched to locate the JavaScript
source file.
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Function
print (expr)

quit ()

Description

This global function evaluates the
expression expr and prints the string
value of the result to the Java Console.
If the Java Console is not open, the
output is discarded. The print
function supplies a trailing new line
character, so each call to print ()
ends a line.

This global function terminates the
current script execution. It is provided
so sample Rhino JavaScript scripts can
be run unmodified within Arbortext
Editor and the Arbortext Publishing
Engine. This function is implemented
by throwing a special
JavaScriptException object; if quit ()
is used inside a try block with a catch, it
will not function as expected.

JavaScript Global Objects

The Arbortext JavaScript implementation provides several global objects available
to all JavaScript scripts. The Application and Acl objects are instances of the AOM
Application and Acl interfaces. Only one object for each interface exists in a
Arbortext Editor or Arbortext PE sub-process session.

Object
Application

Acl

AclException

DOMException
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Description

This global object implements the
Application interface that provides
access to all other DOM and AOM
objects except for the Acl interface.

This global object implements the Acl
interface that provides access to ACL
(Arbortext Command Language).

This is an instance of the class
AclException, raised by some Acl
interface methods.

This is an instance of the class
DOMException, raised by some
DOM interface methods.
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Object
EventException

RangeException

TableException

WindowEXxception

arguments

environment

Using JavaScript to Access the AOM

Description

This is an instance of the class
EventException, raised by some
DOM Event interface methods.

This is an instance of the class
RangeException, raised by some
DOM Range interface methods.

This is an instance of the class
TableException, raised by some
Table interface methods.

This is an instance of the class
WindowException, raised by some
Ul interface methods.

This global array contains the
arguments passed to the js source
ACL function as the args parameter.
The array will have zero length if no
arguments were passed, or if the
JavaScript code was executed by the
javascript ACL function.

This global object provides access to
Java System properties. Accessing an
environment property name results in a
call to
java.lang.System.getProper
ty ("name").

Setting a property name to value
results in a call to
java.lang.System.getProper
ties () .put ("name",
"value").

For example:
environment ["user.dir"] = "c:\\temp"

changes the java user directory system
property.
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Calling Java from JavaScript

The Mozilla Rhino JavaScript interpreter bundled with Arbortext Editor provides
a mechanism called LiveConnect that lets you use Java classes and methods from
JavaScript. The Arbortext Object Model (AOM) classes are written in Java and
made available in JavaScript by LiveConnect.

LiveConnect manages the Java to JavaScript communication, including
conversion of data types. JavaScript: The Definitive Guide, written by David
Flanagan and published by O'Reilly, discusses this subject. There are some
limitations with LiveConnect and the AOM, as noted in JavaScript Limitations on
page 79.

Rhino also supports defining new JavaScript classes by writing Java code that
extends the org.mozilla.javascript.ScriptableObject class. The JavaScript function
defineClass makes such classes available to JavaScript. Refer to the Rhino
documentation at the Mozilla web page for details.

With LiveConnect, Java packages are represented in JavaScript by the
JavaPackage class. You can access the Java classes provided with the JVM
embedded in Arbortext Editor, plus those found in the Java class path (as specified
by the javaclasspath parameter of the setOption method, described in AOM
set Options Overview on page 737) from the top-level JavaPackage object
Packages. This includes the standard Java system classes (for example,
Packages.java.lang.System) and the packages provided by Arbortext
(for example, Packages.com.arbortext.epic,
Packages.org.w3c.dom), and the JavaScript interpreter
(Packages.org.mozilla.javascript). As a convenience, the classes in
the java package can be referred to directly without the Packages qualifier, for
example, java.lang.Systemand java.lang.awt.Frame.

~ Note

The Java Swing classes are in the javax package, so you must fully qualify
the package name (Packages. javax.swing) to use Swing classes.

The global object Application is a shortcut for the
Packages.com.arbortext.epic.Application JavaClass. Similarly,
the global object Ac1 is a shortcut for the
Packages.com.arbortext.epic.Acl JavaClass.

The following JavaScript example uses the standard Java AWT classes to create
and display a dialog box.
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~ Note

Since no event handling is specified in this example, the dialog box cannot be
dismissed.

function hello ()

{

var f = new java.awt.Frame ("Hello World");

var ta = new java.awt.TextArea("hello, world", 100, 200);
f.add ("Center", ta);

f.pack();

f.show () ;

}
hello();

A more complicated example with event handling is included with the Arbortext
distribution. Refer to Sample JavaScript Code on page 86 for details.

JavaScript Interface Error Handling

Errors When Executing JavaScript

When executing JavaScript programs, Arbortext Editor displays error messages if
there are problems when starting the JavaScript interpreter, in the embedded Java
Virtual Machine (JVM), or if the JavaScript interpreter reports an exception. If the
JavaScript interpreter reports an exception, Arbortext Editor displays a message
such as “The Java method name has thrown an exception.” If you use the ACL
function javascript to invoke the JavaScript interpreter, name is eval; if you
use the ACL function js_source, name is source.

The JavaScript exception message is sent to the Java Console if it is open;
otherwise, it is discarded. When developing JavaScript applications, choose Tools
» Java Console to open the Java Console and view exception messages.

For JavaScript code executed by reading a . j s file, the JavaScript exception
report includes a traceback showing the file name and line number of each
function active at the time of the error. The traceback also lists Java methods for
the JavaScript interpreter, which can be ignored.

Exception Handling

JavaScript provides exception handling with try/catch statements. Since
JavaScript is implemented using the Java interface, it supports all the DOM and
AOM exception classes summarized in Java Interface Exceptions on page 71 and
defined in Interface Overview on page 185. Most exception classes define a
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numeric error code attribute named code and message attribute named
message. The symbolic names for the error codes listed with each exception
interface description are available for the global exception objects listed in
JavaScript Global Objects on page 82. For example,
try {

node.insertBefore (newNode, refNode);

}

catch (e) {

if (e.code == DOMException.NO MODIFICATION ALLOWED ERR) {
Application.alert ("Document is read only");

}

else {
Application.alert ("Error: " + e.code +
" Message: " + e.message);

}
}

Specifying the Interpreter for .js Files

Arbortext Editor supports two JavaScript interpreters. You should specify which
interpreter to use to process your . s files. You can include a special comment as
the first line of the file. If the first line of the . j s file using either form specified

in the following examples, then the Rhino JavaScript interpreter will be used.
// type="text/javascript"

or
// <script type="text/Jjavascript">

You can also specify the interpreter with the ACL set
javascriptinterpreter command. However, we recommend using the
commenting technique as it ensures proper handling of your . j s files regardless
of the javascriptinterpreter setting.

Sample JavaScript Code

Sample JavaScript code that uses the JavaScript AOM interface is included in the
Arbortext-path\samples\javascript directory. The readme. txt
file in this directory provides a description of the sample code and how to invoke
the sample scripts. The samples include examples of using the DOM to
manipulate the active document, registering DOM Event handlers, using Java
AWT classes, and transferring arrays between JavaScript and ACL.

There is a sample from the Mozilla Rhino distribution that implements a
JavaScript Fi1le class in Java and an example script, Jsdoc. js, that uses the
defineClass JavaScript extension to define the File class.

Refer to Rhino Examples at the Mozilla web page for additional sample
JavaScript scripts.
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COM Interface Overview

Arbortext Editor includes a Component Object Model (COM) binding to the
AOM. Using this binding, developers on Windows platforms can write programs
that use COM to access the AOM or DOM functions supported in Arbortext
Editor.

COM should be installed on all Windows systems that are running Arbortext
Editor. It is unlikely that your Windows systems will not have COM already
installed on them.

When acting as a COM server, Arbortext Editor registers an
Epic.Application COM class which implements the _ApplicationN interface
(for example, _Application6 — consult the type library for the correct interface
version), an Epic.Acl COM class which implements the 1AcI3 interface, a
number of DOMxxx classes which implement their respective IDOMxxx interfaces,
and many other xxx classes that implement their respective Ixxx AOM interfaces.

If you are trying to use COM among different machines, you will need to install
DCOM (Distributed Component Object Model). Extensive information on both

COM and DCOM is available from the Microsoft Developers Network (MSDN)
web site at msdn.microsoft.com.

The Arbortext Editor COM interface to the DOM portion of AOM uses the COM
binding defined by Microsoft with changes for DOM Level 2 and Arbortext
extensions. However, Microsoft has made several significant extensions to the
DOM that are not supported by Arbortext. The definition of the COM classes and
methods that Arbortext Editor exports is contained in the type library that is part
ofthe Arbortext-path\bin\editor.exe binary. Developers can use a
variety of tools to inspect this type library.

The type library defines multiple versions of many interfaces. When an interface
is extended for a given Arbortext Editor or Arbortext Publishing Engine release, a
new version of the interface is defined with the version number incremented. For
example, the _Application3 interface was introduced with Epic Editor and E3 4.3.

Arbortext Editor or an Arbortext PE sub-process does not need to be running for it
to be available to COM. If Arbortext Editor or an Arbortext PE sub-process is not
running when a call is made to the Arbortext Editor COM server, it will
automatically load and run in the background while servicing the COM call. If a
user then uses the Windows user interface to start a Arbortext Editor session, the
invisible instance that was running exclusively as a COM server automatically
becomes visible and available to the user.
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Registering and Unregistering Arbortext
Editor as a COM Server

When you install Arbortext Editor, the setup program automatically registers
Arbortext Editor as a COM server. The uninstall program will unregister
Arbortext Editor as a COM server.

Starting with release 5.4, Arbortext Editor also automatically checks at startup to
see whether the application is registered as a COM server. If Arbortext Editor
finds that it is not registered as a COM server, it performs a COM registration for
Arbortext Editor itself and all of its installed components as part of the startup
process. This check can be disabled with the APTNOCOMCHECK environment
variable. If the automatic registration fails for some reason (usually because the
user does not have administrator privileges), Arbortext Editor still opens but
displays an error message first saying that this version is no longer configured
correctly. In this case, some Arbortext Editor components might not be available.
You can keep Arbortext Editor from opening in this case with the
APTFAILIFNOCOM environment variable.

If you run a version of Arbortext Editor earlier than 5.4 on the same system with
your current version, you might encounter problems with the earlier version’s
COM registration due to the new automatic COM registration. You can obtain a
utility called register.bat from PTC Technical Support that will correctly
register releases of Arbortext Editor prior to 5.4. For more information, search the
Technical Support knowledge base for TPI 144503.

You can manually register or unregister a Arbortext Editor installation at any time
by running Arbortext Editor with the ~-RegServer, -UnregServer, or
-UnregAnyServer startup command options. In the examples that follow, the
first path to the editor.exe binary is for 64-bit installations, and the second
path is for 32-bit installations.

Arbortext-path\bin\x86\editor.exe —-RegServerArbortext-path\bin
\x86\editor.exe -RegServer

Arbortext-path\bin\x64\editor.exe -RegServerArbortext-path\bin
\x86\editor.exe -RegServer

Registers a specific Arbortext Editor installation as a COM server.
Arbortext-path\bin\x86\editor.exe -UnregServerArbortext-path\bin
\x86\editor.exe -UnregServer

Arbortext-path\bin\x64\editor.exe -UnregServerArbortext-path\bn
\x86\editor.exe -UnregServer

Unregisters a specific Arbortext Editor installation as a COM server. Note that the
-UnregServer option will not remove the editor.exe COM server entry in
the registry, unless the Arbortext Editor installation you are running matches the
Arbortext Editor installation listed as the current editor.exe COM server.
Arbortext-path\bin\x86\editor.exe -UnregAnyServerArbortext-path\bin
\x86\editor.exe -UnregAnyServer

Arbortext-path\bin\x64\editor.exe -UnregAnyServerArbortext-path\bin
\x86\editor.exe -UnregAnyServer
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Unregisters any version of Arbortext Editor on the system as a COM server, not
just the installation for which you are using the option.

Accessing COM Using JScript or
VBScript

You can access the AOM in JScript and VBScript using the COM interface. The
Arbortext Editor Application and Acl objects are exposed to the script
automatically as global objects when using the built-in script interpreters.

You can access external third-party COM objects using the JScript
ActiveXObject object or the VBScript CreateObject and GetObject
functions. Microsoft Excel is an example of a COM server which can be accessed
from Arbortext Editor. For example, to launch Microsoft Excel using JScript, use
the following statement:

var x1 = new ActiveXObject ("Excel.Application");

To launch it using VBScript, use:
Dim x1
set x1 = CreateObject ("Excel.Application")

Both examples provide access to Excel's Application object, which is different
from the Arbortext Editor Application object. (If you were running a script outside
the built-in interpreter, for example, using Excel VBA, you would need to create
an instance of the Arbortext Editor Application object using
Epic.Application.)

Extensive documentation on JScript and VBScript is available from the Microsoft
Developers Network (MSDN) web site at msdn.microsoft.com. Search for the
topic “Windows Script”. Documentation on how to use a COM server, such as
Excel, is provided by the software vendor. In the case of Microsoft Office
products, the VBA (Visual Basic for Applications) documentation is the primary
source of information on the COM objects exposed in each Microsoft Office
application.

COM Objects and ACL

You can use ACL (Arbortext Command Language) to call most COM
(Component Object Model) objects which export the IDispatch interface and
which include a type library.

You can use this functionality, for example, to invoke an application or DLL
written in Visual Basic. Such an external application can, in turn, invoke
Arbortext Editor or an Arbortext PE sub-process using its COM interface to
access or change a document. Keep in mind that calling COM objects from
VBScript or JScript scripts is more straightforward than calling COM objects
from ACL (refer to Accessing COM Using JScript or VBScript on page 90).
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ACL includes a set of functions to support COM calls: com attach, com
call, com prop get,com prop put,and com release.

Use the com_attach function to attach to a COM object and return a handle
that can be used to invoke the object. After a successful com attach, you can
use the object handle to make calls to com call, com prop get, or com
prop_set to invoke a method or get or set a property in a COM interface. Use
the com release function to release an object attached by com attach or
one returned by another interface. These functions are documented in the
Arbortext Command Language Reference.

Arbortext Editor and the Arbortext PE sub-process use the type library associated
with a COM interface to determine the type of each argument and the return value
of a method or property invoked using an ACL function. This makes it possible,
for example, to pass ACL variables to COM methods that expect parameters
passed by reference and have the COM object return results to ACL by changing
the value of the variable.

Arbortext Editor and Arbortext Publishing Engine have some restrictions and
limitations in their support for calling COM interfaces, many of which are
inherent to ACL:

* Named arguments are not supported.
* Arguments can be omitted only at the end of the argument list

* You cannot pass an ACL array to a COM interface as an array. You can pass a
member of an ACL array as an individual argument.

* A called COM interface function can't return an array and have it converted
into an ACL array.

* You cannot use the other information in a type library (such as enum
definitions) in ACL.

* There is no implicit support for the implied Value, NewEnum, or
Evalute methods and properties even though it may be possible to call them
explicitly.

COM Error Handling

All of the Arbortext Editor COM interfaces support the Errorinfo COM interface
and use it to pass error messages to the client if the called method fails. All
supplied methods return an HRESULT which indicates success or failure and the
general nature of the failure. Developers can use standard COM practices to
retrieve error codes and error messages.

The DOM specification indicates that several methods will raise an exception
upon certain types of failure. This is also the case for several AOM methods.
Since the COM interface doesn't support exceptions, these failures will be turned
into HRESULT return values. The specific value returned for a given exception

Using COM to Access the AOM 91



can be found in the type library for the Arbortext-path\bin\editor.exe
binary. They're also presented in the tables that follow. The general rule is that
these exceptions will be returned as DOM_E YYY ERR for the DOMException,
EventException and RangeException errors, TABLE E YYY ERR for
TableException errors, WINDOW E YYY ERR for WindowException errors, and
EXECUTE E YYY for AclException errors.

The following tables list the COM error codes and values for each range of errors.
See the exception interface definitions in Interface Overview on page 185 for the

exception codes and their meanings.

DOM Error Codes

Error Code Value
DOM_E_INDEX_SIZE ERR 0x80042101
DOM_E DOMSTRING SIZE ERR 0x80042102
DOM_E HIERARCHY REQUEST ERR 0x80042103
DOM_E_WRONG DOCUMENT ERR 0x80042104
DOM E INVALID CHARACTER ERR 0x80042105
DOM_E NO DATA ALLOWED_ERR 0x80042106
DOM_E NO MODIFICATION ALLOWED ERR 0x80042107
DOM_E NOT _FOUND_ERR 0x80042108
DOM_E NOT SUPPORTED ERR 0x80042109
DOM _E INUSE ATTRIBUTE ERR 0x8004210A
DOM_E _INVALID STATE ERR 0x8004210B
DOM_E SYNTAX ERR 0x8004210C
DOM_E _INVALID MODIFICATION ERR 0x8004210D
DOM_E NAMESPACE_ERR 0x8004210E
DOM_E INVALID ACCESS ERR 0x8004210F
DOM_E VALIDATION ERR 0x80042110
DOM_E UNSPECIFIED EVENT TYPE ERR 0x80042148
DOM_E BAD BOUNDARYPOINTS ERR 0x80042141
DOM_E _INVALID NODE TYPE ERR 0x80042142
DOM_E NO SCHEMA AVAILABLE ERR 0x80042647
Table Interface Error Codes

Error Code Value
TABLE E TABLE OPERATION FAILED ERR 0x80042301
TABLE E TABLE INVALID INDEX ERR 0x80042302
TABLE E TABLE INVALID DIRECTION ERR 0x80042303
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Table Interface Error Codes (continued)

Error Code Value
TABLE _E TABLE INVALID ORIENTATION ERR 0x80042304
TABLE _E TABLE INVALID SPAN ERR 0x80042305
TABLE_E TABLE INVALID PARAMETER ERR 0x80042306
TABLE_E TABLE INVALID ATTRIBUTE ERR 0x80042307
Window Interface Error Codes

Error Code Value
WINDOW_E WINDOW_NOT SUPPORTED ERR 0x80042401
WINDOW_E WINDOW_ HIERARCHY REQUEST ERR 0x80042402
WINDOW_E WINDOW_WRONG_ WINDOW_ERR 0x80042403
WINDOW _E_WINDOW NOT FOUND_ ERR 0x80042404
WINDOW_E_WINDOW _INVALID COLOR_ERR 0x80042405
WINDOW_E WINDOW _INVALID MODIFICATION ERR |0x80042406
WINDOW_E_WINDOW_NO MODIFICATION _ 0x80042407
ALLOWED ERR
Acl.Execute Error Codes

Error Code Value
EXECUTE _E PARSE FAILURE 0x80042200
EXECUTE_E ERROR 0x80042201
EXECUTE _E INTERNAL ERROR 0x80042202

JScript maps the COM errors to the Error object, and VBScript maps the COM
errors to the Err object. See JScript Exception Handling on page 99 and

VBScript Error Handling on page 103 for details.

Sample COM Code

Sample Visual Basic and Visual C++ code that uses the COM interface is included

inthe Arbortext-path\samples\com directory. The Readme file in this

directory provides details on the samples.

Using COM to Access the AOM
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JScript Interface Overview

Arbortext Editor and the Arbortext Publishing Engine include a JScript binding to
the AOM. Using this binding, software developers can use the JScript
programming language to write applications for Arbortext Editor and the
Arbortext Publishing Engine.

Arbortext uses Microsoft Windows Script (or ActiveScript) as the JScript
interpreter. This script engine is represented primarily by the system files
jscript.dll and scrrun.dll.

The AOM interface and the DOM interface for JScript are implemented using the
Arbortext COM interface. Access to external COM servers is implemented
through standard COM interfaces used by the Microsoft script engines.

~ Note

By default, all JScript code is executed in a single global context, in a
namespace called EpicJsS. A JScript instance can create nested JScript
instances which use unique namespaces. See the description of the
createScriptContext method for the AOM Application object in
createScriptContext method on page 281.

JScript Platforms

The JScript interface is a Windows-only technology.

JScript with ACL

JScript expressions or scripts can be called from ACL with one of the following
ACL primitives:

* jscript — Function that evaluates a JScript expression and returns the
result as a string.
* js— Command that evaluates a JScript expression and displays the result.

* source — Command that interprets files ending in . j s as JavaScript
programs to be executed when set javascriptinterpreter issetto
jscript.

The flow of control in the JScript interface usually starts with the execution of one

of these ACL functions or commands, with the exception of customization files
ending in . js. Arbortext Editor and the Arbortext PE sub-process automatically
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load and execute JScript programs from the doctype. js, instance. js, and
document. js files following the same rules as doctype.acl,
instance.acl, and docname.acl files.

The JScript interpreter starts the first time Arbortext Editor or the Arbortext PE
sub-process executes one of these ACL functions or commands or reads a . j s
customization file. Arbortext Editor and the Arbortext PE sub-process will also
start the Java Virtual Machine, if necessary. You may also specify the -j s startup
command option to start JScript when Arbortext Editor is opened.

Unlike the Java interface, only string arguments are passed from ACL to JScript.
ACL arrays must be converted to some form of delimited string (for example, as
an array literal) or passed element by element to JScript expressions. Refer to
Passing Arrays Between JavaScript and ACL on page 97 for more details.

JScript objects may not be returned directly to ACL. If the result of a JScript
expression passed to Javascript is an object, the toString method is
invoked on the object and that value is returned by javascript.

Passing Arrays Between JavaScript and ACL

There are two ways to pass arrays between JScript and ACL, both involving the
conversion of arrays to strings. The first method uses the JScript Array.join method
to convert the JScript array to a string that is passed to the ACL split function.

For example, the JScript code
var jsArr = [1, 2, 31;
Acl.eval ("split('" + jsArr.join() + "', aclArr, ',")");

converts the JScript array jsArr to the ACL array aclArr.

1 Note
ACL arrays normally start at index 1, which is the same as JavaScript index 0.

The second method uses a loop to pass the array, element by element. The Acl.eval
call in the previous example can be rewritten as:

for (var i = 0; 1 < JsArr.length; i++) {

var ai =1 + 1;

Acl.eval ("aclArr[" + ai + "] = "" 4+ JsArr[i] + "'");

}

This method is slower, but isn't subject to the ACL string token limit of 4096
characters.

Similarly, there are two ways to retrieve an ACL array from JScript. The first
method uses the ACL join function to concatenate the ACL array into a string
that initializes a JScript array. For example, you can use the following ACL code
to pass the ACL array created above to JScript:
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javascript ("var jsArr = [" . join(aclArr) . "1");
This method is not limited by the ACL string token limit.

You can also use a loop to retrieve the array, element by element, as shown in the
following JScript example:

var count = parselnt (Acl.eval ("count (aclArr)"));
var lowBound = parselnt (Acl.eval ("low bound(aclArr)"));
var JjsArr = new Array(count);

for (var 1 = 0; i < count; i++) {

var ai = lowBound + i;

jsArr[i] = Acl.eval ("aclArr[" + ai + "1");

}

This method translates the arbitrary array index bounds in an ACL array to the
zero-based array index in JScript. It also uses the parselnt method to convert the
Java string returned by Acl.eval into a JScript number.

Associative arrays

The previous examples concern normal numeric indexed arrays. You can use
equivalent techniques to pass associative arrays using for/in loops instead of
the for loops as above. The following JScript example passes an associative

array to ACL:

var jsAssoc = {one: 1, two: 2, three: 3};

for (var i in jsAssoc) {

Acl.eval ("aclAssoc['" + 1 + "']='" + JsAssoc[i] + "'");

}

You can pass an ACL associative array to JScript using the ACL join function
or an ACL for/in loop similar to the JScript example. The following ACL
example shows the join technique to declare a JScript array using object literal
syntax:

javascript ("var jsAssoc={" . join(aclAssoc,',',1) . "™

~ Note

The ACL join function also works for associative arrays, and produces a
result that can be used to initialize a JavaScript associative array object as in
the previous example.

JScript Limitations
Some limitations of the Arbortext JScript implementation are:

» JScript is not case-sensitive. Rhino JavaScript is case-sensitive. AOM and
DOM compatiblity between JScript and JavaScript files requires the script
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author to comply with the capitalization of methods and attributes described in
this guide.

* The AOM and DOM constants are not defined in the global context. They
must be defined inline in JScript files to be referenced by variable name.

AOM Interfaces Specific to JScript

By default, JScript instances run in a single global context, or namespace, called
EpicJs. The AOM includes JScript-specific features related to the ScriptContext
interface:

* createScriptContext—allows scripts to create and run nested scripts in
the global namespace (EpicJS) or in a user-defined context or namespace.

* getScriptContext—retrieves a reference to any running script context
by namespace.

See the descriptions in Application interface on page 269 and ScriptContext
interface on page 625 for more information.

JScript Global Objects

The Arbortext JScript implementation provides several global objects available to
all JScript scripts. The Application and Acl objects are instances of the AOM
Application and Acl interfaces. Only one object for each interface exists in a
Arbortext Editor session.

Object Description

Application This global object implements the

Application interface that provides
access to all other DOM and AOM
objects except for the Acl interface.

Acl This global object implements the Acl

interface that provides access to ACL
(Arbortext Command Language).

JScript Exception Handling

JScript provides exception handling with try/catch statements. JScript is
implemented using the COM interface, so it does not support the DOM and AOM
exception classes. All exceptions are mapped to the JScript Error global object.
The COM error code values listed in COM Error Handling on page 91 are
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available using the number property of the Error object. The message
associated with the exception is available using the description property. For

example:
try {

doc.insertBefore (doc, doc); // this is invalid

}
catch(e) {

Application.alert ("Error: " + (e.number&Oxffff) +
" Description: " + e.description);

}

Specifying the Interpreter for . js Files

Arbortext Editor supports two JavaScript interpreters on Windows. You should
specify which interpreter to use to process your . js files. You can include a
special comment as the first line of the file. If the first line of the . j s file contains
a comment using either form specified in the following examples, then the
Microsoft JScript interpreter will be used.

// application="text/jscript"

or
// <script application="text/jscript">

You can also specify the interpreter with the ACL set
javascriptinterpreter command. However, we recommend using the
commenting technique as it ensures proper handling of your . j s files regardless
of the javascriptinterpreter setting.

Sample JScript Code

Sample JScript code that uses the JScript AOM interface is included in the
Arbortext-path\samples\jscript directory. The readme. txt file in
this directory provides a description of the sample code and instructions for
invoking the sample scripts. Examples show how to use the DOM to manipulate
the active document, register DOM Event handlers, and transfer arrays between
JScript and ACL. The JScript examples are ported from the corresponding Rhino
JavaScript samples of the same name.
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VBScript Interface Overview

Arbortext Editor and the Arbortext Publishing Engine include a VBScript binding
to the AOM. Using this binding, software developers can use the VBScript
programming language to write applications for Arbortext Editor and the
Arbortext Publishing Engine.

Arbortext uses Microsoft Windows Script (or ActiveScript) as the VBScript
interpreter. This script engine is represented primarily by the system files
vbscript.dll and scrrun.dll.

The AOM interface and the DOM interface for VBScript is implemented via
Arbortext's COM interface. Access to external COM servers is implemented
through standard COM interfaces used by the Microsoft script engines.

~ Note

By default, all VBScript code is executed in a single global context, in a
namespace called EpicVBS. A VBScript instance can create nested VBScript
instances which use unique namespaces. See the createScriptContext
method for the AOM Application object in createScriptContext method on
page 281.

VBScript Platforms

The VBScript interface is a Windows-only technology.

VBScript and ACL

VBScript expressions or scripts can be called from ACL with one of the following
ACL primitives:

* vbscript — Function that evaluates a VBScript expression and returns the
result as a string.

* source — Command that interprets files ending in . vbs as JScript
programs to be executed.

VBScript Limitations

Some limitations of the Arbortext VBScript implementation are:
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* VBScript is not case-sensitive.

* The AOM and DOM constants are not defined in the global context. They
must be defined inline in VBScript files to be referenced by variable name.

AOM Interfaces Specific to VBScript

By default, VBScript instances run in a single global context, or namespace,
called EpicVBS. The AOM includes VBScript-specific features related to the
ScriptContext object:

* createScriptContext — allows scripts to create and run nested scripts
in the global namespace (EpicVBS), or in a user-defined context or
namespace.

* getScriptContext — retrieves a reference to any running script context
by namespace.

See the descriptions in Application interface on page 269 and ScriptContext
interface on page 625 for more information.

VBScript Global Objects

The Arbortext VBScript implementation provides several global objects available
to all VBScript scripts. The Application and Acl objects are instances of the AOM
Application and Acl interfaces. Only one object for each interface exists in a
Arbortext Editor session.

Object Description

Application This global object implements the

Application interface that provides
access to all other DOM and AOM
objects except for the Acl interface.

Acl This global object implements the Acl

interface that provides access to ACL
(Arbortext Command Language).

VBScript Error Handling

VBScript does not support exceptions, so the DOM and AOM exception classes
are not available. All exceptions are mapped to the VBScript Exrr global object.
The COM error code values listed in COM Error Handling on page 91 are
available using the Number property of the Err object. The message associated
with the exception is available using the Description property. For example:
On Error Resume Next
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doc.insertBefore doc, doc ' this is invalid
If Err.Number <> 0 Then

Application.alert ("Error: " & Err.Number
& " Description: " & Err.Description)
Err.Clear
End if

Sample VBScript Code

Sample VBScript code that uses the VBScript AOM interface is included in the
Arbortext-path\samples\vbscript directory. The readme. txt file
in this directory provides a description of the sample code and instructions for
invoking the sample scripts. Examples show how to use the DOM to manipulate
the active document and register DOM event handlers. There are two samples,
commdlg.vbs and graphic-browser.vbs, which show how to use COM
to launch and communicate with Microsoft Word and Microsoft Excel. The
VBScript examples are ported from the corresponding JScript samples of the same

name.
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Overview of Programming and
Scripting Techniques

This part of the Programmer's Reference contains information on using Arbortext
Editor and the AOM to perform basic and advanced operations. Individual
chapters include:

Overview on page 110 — Contains a series of examples demonstrating basic
techniques for manipulating documents and content using the DOM and
AOM.

Overview on page 120 — Summarizes the DOM Event Model interfaces and
the AOM extended event interfaces supported by Arbortext Editor and the
Arbortext Publishing Engine.

Working with Tables Overview on page 156 — The AOM contains interfaces
that provide access to more than 100 Arbortext Editor table functions. This
chapter provides several examples that illustrate the basics of inserting and
manipulating tables using the interfaces.

Overview on page 164 — XSL composition refers to Arbortext Editor's ability
to transform a document using XSL or XSL-FO stylesheets. This chapter
describes XSL composition and its components, and provides an example of
calling the composition pipeline for an HTML file composition.

Line Numbering Overview on page 170 — You can add line numbers to your
document, specifying their format using a custom application. This chapter
describes the basic line numbering functionality that is available with a
Arbortext distributed document type, and detailed instructions for building
your own.
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Overview

This chapter contains a series of brief examples demonstrating basic techniques
for manipulating documents and content using the DOM and AOM. The examples
cover opening, closing, and saving documents; traversing document trees;
inserting text; and locating, selecting, cutting, and pasting content in and between
documents.

Most of the sample code in this chapter can be run on the Arbortext XML
Docbook sample opened with Arbortext Editor. (Choose File » New, check
Sample, select Arbortext XML Docbook V4.0, and click OK.) Example code that
calls openDocument requires access to one or two saved copies of the
Arbortext XML Docbook sample.

All of the examples in this chapter are written in JavaScript.

Opening, Closing, and Saving documents

DOM Level 2 does not provide methods to open, save, and close documents.
However, the AOM includes methods on the Application and ADocument
interfaces that implement these capabilities.

The Application interface openDocument method returns a Document object
that has information about a document or document type and can be used to
dynamically update the content, structure, and style of the document

The openDocument method takes several optional parameters, including the
flags parameter, which controls the state in which the document is opened. This
parameter is constructed by adding the hex values of the LoadF1ag enumeration
constants. (The symbolic constant names can be used instead with some language
bindings.) Refer to Application interface on page 269 for a complete listing and
full descriptions of the LoadF1ag enumeration constants. The following table
highlights a selection of these constants.

Name Hexadecimal value Description

OPEN_RDONLY 0x0001 Open the document as
read only.

OPEN_DOCRDWR 0x0002 Open the document for
read and write.

OPEN_NOMSGS 0x0020 Suppress any parser error
messages.

OPEN EDITINIT 0x8000 Process initialization files

upon opening.
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In the following code, the flags parameter is used to open a document for read and
write while suppressing any parser errors:

var doc = Application.openDocument ("mydocument.xml", (0x0002 + 0x0020))

Once a document is opened, it can be manipulated and then saved and closed
using methods of the ADocument interface (which extends the W3C DOM
Document interface).

ADocument.save writes the document to disk. The save method's flags parameter
determines the state of the saved document.

ADocument.close frees all resources associated with the Document object.

Refer to the examples in the remainder of this chapter for several sample uses of
the Application.openDocument, ADocument.save, and ADocument.close methods.

Traversing a Document Using the DOM
and AOM

A Document object is the tree representation of the document's structure. Like any
tree, the document can be traversed several ways.

Traversing and Printing a Document Structure

In this example, as the document is traversed, the tag name and up to the first 60
characters of each node are printed to illustrate the hierarchical structure of the
current document.

In addition to demonstrating how to walk a DOM tree, this example also shows
how to access the names of nodes (Node.nodeName), how to determine a node's
type (Node.nodeType = text, element, comment, or processing instruction), and
how to extract text content from a document (Node . data).

function printTree(n, elem) {

if (elem == null) {

if (n == 0)

print ("document has no element nodes");

return;

}

var str = "";

for (var i = 0; 1 < n; 1i++)

str 4= " ";

// show this node

print (str + elem.tagName + getAttrs(elem));

str += " ";

// followed by its children

for (var child = elem.firstChild; child != null;

child = child.nextSibling) {

if (child.nodeType == child.ELEMENT NODE)
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printTree(n + 1, child);

else if (child.nodeType == child.TEXT NODE) {

// for text nodes, show the first 60 characters

// note, concatentation with a null string is used to convert
// the Java String returned into a JavaScript string.

var text = child.data + "";

if (text.length > 60)

print (str + '"' + text.substr (0, 60) + "...\"");
else

print(str + '"' + text + '""');

}

else if (child.nodeType == child.COMMENT NODE) {
var text = "#comment: " + child.data;

if (text.length > 60)
text = text.substr (0, 60) + "...";
print (str + text);

}
else if (child.nodeType == child.PROCESSING INSTRUCTION_ NODE)

print(str + "#pi: " + child.target + ' ' + child.data);
else // all others

print (str + child.nodeName) ;

}

}
// start at the root
printTree (0, Application.activeDocument.documentElement) ;

Using getElementsByTagName

In this example, the tree is traversed by calling getElementsByTagName. All
of the Document, ADocument, Element, and AElement interface
getElementsByXxx methods populate a NodeList with nodes in the order
encountered in a preorder traversal of the tree. All occurrences of the
<emphasis> tag have their role attribute value changed from bold to
italic, changing all bold text to italic. This is done by iterating over the
NodeList returned by getElementsByTagName, and using
Node.getAttribute to check the value of each node's role attribute, and
then using Node . setAttribute to change that value to italic.

var doc = Application.activeDocument;

//get all emphasis tags in the document

var tags = doc.getElementsByTagName ("emphasis");
for (i=0; 1 < tags.length; i++) {
if(tags.item(i) .getAttribute ("role") == "bold") {
tags.item(i) .setAttribute ("role", "italic")

}
}
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Using getElementsByAttribute

The previous example could be improved by using the AElement.
getElementsByAttribute method. (The AOM AElement interface extends the W3C
DOM Element interface.) Doing so will return only those tags from the document
that have the role attribute set to bold. The value on all of the tags can then be
changed from bold to italic without having to test every <emphasis> tag
in the document.

The getElementsByAttribute method takes three arguments: name, value,
and selector. If selector is set to 1 (one), the search will return all nodes that
match both name and value. If selector is set to 0 (zero), all nodes matching name,

regardless of their value, are returned.
var doc = Application.activeDocument;

var tags = doc.getElementsByAttribute ("role", "bold", 1);
for (i=0; 1 < tags.length; i++) {
tags.item(i) .setAttribute ("role", "italic");

}

Inserting Text

Text can be added at any appropriate place in a document by creating and

inserting a new Text node. Document.createTextNode takes a text string as an
argument, and returns a new node (Text object) that can be inserted by calling
methods such as Node.appendChild or Node.insertBefore on the desired node.

Inserting Text Using createTextNode

This example appends the line “Adding new text.” to the end of the first
paragraph in a document

var doc = Application.activeDocument;

var paras = doc.getElementsByTagName ("para") ;

//create the new Text Node

var newText = doc.createTextNode (" Adding new text.");
//append it to first paragraph

paras.item(0) .appendChild (newText) ;

Inserting Text Containing a Non-Latin Character

To insert a string containing characters such as letters from non-English alphabets,
include the Unicode character in the text string. Do not include it as an entity
reference.

For example, suppose you are authoring a travel guide and wish to append a

paragraph that includes the German word Gemiit 1ichkeit. If you include the ¢

as an entity reference, the entity will not be resolved. For example:

var newTextl = doc.createTextNode ("Austrians are known for their
Gem&uuml; tlichkeit");
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The text node will literally contain “Gem&uuml; t1ichkeit”. Instead, insert

the character as in the following example:

var doc = Application.activeDocument;

var paras = doc.getElementsByTagName ("para");

var newText = doc.createTextNode (" Austrians are known for their Gemutlichkeit");
paras.item(0) .appendChild (newText) ;

Inserting an Entity Reference Using
createEntityReference

To insert such characters as an entity references, use Document.
createEntityReference rather than createTextNode. This example produces
the same result as the previous example, but uses a character entity to insert the u-
umlaut:

var doc = Application.activeDocument;

var paras = doc.getElementsByTagName ("para");

var newTextl = doc.createTextNode ("Austrians are known for their Gem");
var charEnt = doc.createEntityReference ("uuml");

var newText2 = doc.createTextNode ("tlichkeit");

paras.item(0) .appendChild (newTextl) ;
paras.item(0) .appendChild (charEnt) ;
paras.item(0) .appendChild (newText?2) ;

Using Range to Select and Delete Content

The W3C DOM Range API consists of a single interface, Range. This interface
exposes the ability to select contiguous portions of a structured document,
delineated by specified beginning and end points. The Range interface contains
methods that allow copying, inserting, or deleting of content, as well as methods
for marking the start and end points of the content range.

Deleting Sections of a Document Using a Range
This example illustrates several basic techniques:

* Opening a document using the optional flags parameter (Application.
openDocument).

* QGathering elements by attribute name and value
(getElementsByAttribute).

* Prompting for user input (Application.confirm).

» Using a range to mark content for deletion and delete it (the deleteTag
function).

* Handling a NodeList.
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The result of the code in this example is that the user is prompted with the option
to delete all the tags in a document that have a certain profiling attribute.

The deleteTag function in the example demonstrates the creation, marking,
and use of a Range object. First the Range must be created (Document.
createRange). The beginning and end points must then be set (Range.
setStartBefore and Range.setEndAfter). The content in the Range is then deleted,
and the range is detached.

The call to Range.detach() is critical, as this method frees all resources associated
with this Range object. Any subsequent call on that object would result in an
exception being thrown. This method should be called whenever a use of a Range
object is complete.

//Delete the given node (tag and its children and/or contents)
function deleteTag(tag) {

var range = doc.createRange();

range.setStartBefore(tag);

range.setEndAfter (tag);

range.deleteContents() ;

range.detach();

}

//0Open the document for writing, while suppressing any parse errors

//OPEN_DOCRDWR (0x0002) - open the document for reading and writing
//OPEN_NMSGS (0x0020) - suppress any parser error messages

var doc = Application.openDocument ("sample.xml", (0x0002 | 0x0020));
//Select all tags with the profiling attribute "security" and the value
"Employee"

var profiles = doc.getElementsByAttribute ("security", "Employee", 1);
//Prompt the user to delete the selected tags
var response = Application.confirm("Found " + profiles.length +

" profiled items.\nOK to delete?", "Confirm Deletion");

//1f the user clicked "OK", go ahead and delete them

if (response) {

while (0 < profiles.length) {

deleteTag (profiles.item(0));

}

}

Notice in this example that in the loop that calls deleteTag, itis item (0) that
is deleted each time. This is because in the W3C DOM NodelList specification,
NodeLists are live. That is, changes in the underlying document object are
immediately reflected in the NodeList.

For example, if tags had been deleted using the following code, only every other
node would have been deleted.
for(i = 0; 1 < profiles.length; i++) {
deleteTag (profiles.item(i));
}
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Selecting, Copying, Moving Content

The following examples demonstrate how to copy, cut, and paste content within
and between documents.

Cutting and Pasting within a Document

This example swaps the position of the first two chapters in a document. When
chapter one is inserted before chapter three, it is the same as a cut and paste; it is
not a copy of the node, but the node itself that is being moved.

var doc = Application.openDocument ("samplel.xml");

//Get the nodes contining chapters one and three from the document
//Chapter three will be the node to insert before

var chapters=doc.getElementsByTagName ("chapter");

var chapterl = chapters.item(0);

var chapter3 chapters.item(2);

var book = doc.getElementsByTagName ("book").item(0) ;

//chapterl is the new node, and chapter3 is the reference
book.insertBefore (chapterl, chapter3);

Copying and Pasting within a Document

A copy and paste within a document can be done by cloning the contents of
chapter one before inserting them before chapter three. In this example, the result
will be two copies of chapter one in the document; one before and one after
chapter two.

var doc = Application.openDocument ("samplel.xml") ;

var chapters=doc.getElementsByTagName ("chapter");

var chapterl = chapters.item(0);

var chapter3 = chapters.item(2);

var book = doc.getElementsByTagName ("book").item(0) ;

var range = doc.createRange () ;

range.setStartBefore (chapterl);

range.setEndAfter (chapterl) ;

var clone = range.cloneContents();

book.insertBefore (clone,chapter3);

range.detach () ;

Copying and Pasting between Documents

Content can also be moved between documents using Document.importNode. The
code in this example results in a copy and paste without the need to clone the
region from the first document. This is because Document.importNode does not
alter or remove content from the original document; it creates a new copy of the
source node — in effect, cloning it. This example also demonstrates the use of
ADocument.openDocument, the use of optional flags and path parameters on
ADocument.save, and ADocument.close.
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var docl = Application.openDocument ("samplel.xml");

var doc2 = Application.openDocument ("sample2.xml") ;

//Get the first chapter from samplel.xml and sample2.xml

var samplelChapter = docl.getElementsByTagName ("chapter") .item(0) ;
var sample2Chapter = doc2.getElementsByTagName ("chapter") .item(0);
var book = doc2.getElementsByTagName ("book") .item(0) ;

//Import the chapter from samplel.xml into sample2.xml

var newChapter = doc2.importNode (samplelChapter, true);

//insert the chapter

book.insertBefore (newChapter, sample2Chapter) ;

//SAVE NAC ENTREF (0x0400) - write non-ascii characters as

// character entity references

doc2.save (0x0400, "newSample2.xml");

docl.close();

doc2.close();

To execute a cut and paste between documents, select and delete the contents in
the original document after inserting it in the target document.

Inserting Text at the Caret

This example shows how to insert text in the document where the caret is located
using the Range returned by the ADocument . insertionPoint attribute. If
the caret is within a text node, the text is inserted into that node. Otherwise, a new
text node is inserted before the insertionPoint node.

var doc = Application.activeDocument;

var caret = doc.insertionPoint;

var node = caret.endContainer;

if (node.nodeType == node.TEXT NODE)

node.insertData (caret.endOffset, " new text ");

else

caret.insertNode (doc.createTextNode (" new text "));

Inserting Markup at the Caret

The ARange extension includes the method insertParsedString. This
method makes it easy to insert strings containing markup (tags and entity
references) into a range, including the one that represents the document caret
position. The following two examples are equivalent and insert the string “an
emphasized word” with the second word “emphasized” enclosed in
<emphasis> tags. The first example is implemented using standard DOM
methods:

var doc = Application.activeDocument;

var caret = doc.insertionPoint;

var node = caret.endContainer;

var parent = node.parentNode;

// does not consider caret offset into text node
parent.insertBefore (doc.createTextNode ("an "), node);

var emph = doc.createElement ("emphasis");
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emph.appendChild (doc.createTextNode ("emphasized")) ;
parent.insertBefore (emph, node);
parent.insertBefore (doc.createTextNode (" word"), node);

The following example uses the ARange.insertParsedString method:
var doc = Application.activeDocument;
doc.insertionPoint.insertParsedString ("an <emphasis>emphasized</> word");
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Overview

Arbortext Editor and the Arbortext Publishing Engine implement the W3C DOM
Event Model described in the Document Object Model (DOM) Level 2 Events
Specification (www.w3.org/TR/DOM-Level-2-Events). The DOM Event Model is
a generic event system that provides registration of event handlers, describes the
flow of events through a tree structure, and defines contextual information for

each event.

Event Interfaces

The following tables summarize the DOM Event Model interfaces and the AOM
extended event interfaces supported by Arbortext Editor and the Arbortext

Publishing Engine.

W3C Event Interfaces

Interface Description

DocumentEvent Implemented by objects that implement the Document
interface to create user dispatched events.

Event Provides contextual information for an event handler. The

superinterface of more specific event context interfaces.

EventException

Exception thrown by event related methods.

EventListener

Mechanism for handling events.

EventTarget

Implemented by objects that implement the Node and
Component interfaces to allow registration and removal of
EventListeners and dispatching of events.

MouseEvent

Provides contextual information associated with Mouse
events.

MutationEvent

Provides contextual information associated with Mutation
events.

UlIEvent

Provides contextual information associated with User
Interface events.

AOM Event Interfaces

Interface Description

ADocumentEntityEvent Provides specific contextual information
associated with the
ADocumentEntityEvent extension.

ADocumentEvent Provides specific contextual information
associated with document events.

ActivexEvent Provides specific contextual information
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AOM Event Interfaces (continued)

Interface Description
associated with Activex events.
AEditEvent Provides contextual information associated
with EditEvent events.
AEvent Extension to the W3C DOM Event interface.

ApplicationEvent

Provides specific contextual information
associated with application events.

CMSObjectEvent

Provides specific contextual information
associated with the CMSObjectEvent
extension.

CMSSessionConstructEvent

Provides specific contextual information
associated with the
CMSSessionConstructEvent extension.

CMSSessionCreateEvent

Provides specific contextual information
associated with the
CMSSessionCreateEvent extension.

CMSSessionFileEvent

Provides specific contextual information
associated with the
CMSSessionFileEvent extension.

CMSSessionBurstEvent

Provides specific contextual information
associated with the
CMSSessionBurstEvent extension.

CMSSessionDisconnectEvent

Provides specific contextual information
associated with the
CMSSessionDisconnectEvent
extension.

CMSAdapterConnectEvent

Provides specific contextual information
associated with the
CMSAdapterConnectEvent extension.

CMSAdapterDisconnectEvent

Provides specific contextual information
associated with the
CMSAdapterDisconnectEvent
extension.

ControlEvent

Provides specific contextual information
associated with Control events.

MenuEvent

Provides contextual information associated
with Menu events.

Events
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AOM Event Interfaces (continued)

Interface Description

ToolBarEvent Provides specific contextual information
associated with ToolBar events.

WindowEvent Provides contextual information associated
with Window events.

Event Modules and Domains

The DOM Level 2 Events specification allows an application to support multiple
modules of events. Arbortext Editor and the Arbortext Publishing Engine support
all of the DOM Level 2 event modules except HTMLEvents. In addition,
Arbortext Editor and the Arbortext Publishing Engine add several application-
specific event modules and further divide the event modules into the following
event domains: CMSObject, CMSSession, CMSAdapter, Document, and
Window.

The Document domain includes those events created by the createEvent
method of the DocumentEvent interface and used by the EventTarget interface as
implemented by the Node interface and its subclasses. The Document domain
includes the DOM Level 2 Event modules UIEvents, MouseEvents, and
MutationEvents, as well as the Arbortext-specific AEditEvent module.
The AEdi tEvent module defines several event types used to notify
programmers of important document operations that are not covered by DOM
events.

The Window domain includes those events created by the createEvent
method of the Window interface and used by the EventTarget interface as
implemented by the Component interface and its subclasses. The Window domain
includes the WindowEvents, MenuEvents and ControlEvents modules.

The CMSSession domain includes those events associated with CMS sessions.
The target of all events in this domain is a CMSSession. The events in this
domain bubble in the following order:

1. CMSSession
2. Associated CMSAdapter
3. Application

An EventListener may be established on any of these targets.

122 Programmer's Reference



The CMSObject domain includes those events associated with CMS objects. The
target of all events in this domain is a CMSObject. The events in this domain
bubble in the following order:

1. CMSObject

2. Associated Document (if any). There may be no associated document, for
example, if the object has no associated nodes (such as an object representing
a folder in the repository).

3. Associated CMSSession

4. Associated CMSAdapter

5. Application

An EventListener may be established on any of these targets.

The CMSAdapter domain includes those events associated with CMS adapters.
The target of all events in this domain is a CMSAdapter. The events in this
domain bubble in the following order:

1. CMSAdapter
2. Application
An EventListener may be established on both of these targets.

The AEvent interface is the Arbortext extension to the W3C Event interface which
adds two attributes to determine the domain and module of the event:

* domain — returns a constant identifying the event domain
* moduleType — returns a constant identifying the event module

The following event modules are supported. The module name listed is the feature
string to pass as the eventType parameter to the appropriate createEvent
method.

UlIEvents

Events associated with user interaction with a mouse or keyboard.

Domain: Document
MouseEvents

Events associated with mouse input devices.

Domain: Document
MutationEvents

Events associated with actions that modify the structure of the document.

Domain: Document
AEditEvents

Events associated with high level editing operations.

Domain: Document
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WindowEvents
Events associated with changes in the state of Window objects.

Domain: Window
MenuEvents

Events associated with MenuItem objects.

Domain: Window
ControlEvents

Events associated with XUI control objects. These are not currently exposed
through the AOM.

Domain: Window
CMSObjectEvent

Events associated with CMS objects.

Domain: CMSObject
CMSSessionConstructEvent

Events associated with construct operations for existing CMS objects.

Domain: CMSSession
CMSSessionCreateEvent

Events associated with creating new CMS objects.

Domain: CMSSession
CMSSessionFileEvent

Events associated with file-related CMS session operations.

Domain: CMSSession
CMSSessionBurstEvent

Events associated with burst-related CMS session operations.

Domain;: CMSSession
CMSSessionDisconnectEvent

Events associated with CMS session disconnection operations.

Domain: CMSSession
CMSAdapterConnectEvent

Events associated with CMS adapter connection operations.

Domain: CMSAdapter
CMSAdapterDisconnectEvent

Events associated with CMS adapter disconnection operations.
Domain: CMSAdapter
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~ Note

The DLMEvent module supports events associated with the Dynamic Link
Manager. It is a Java-only implementation that is documented in the Javadoc
available in the Arbortext Editor Help Center.

Application-Dependent Features

The DOM Level 2 Events specification defines the DOMFocusIn,
DOMFocusOut, and DOMActivate user interface events, but does not define
when they will occur. The specification also allows implementation-dependent
treatment of the DOMSubt reeModi fied mutation event. The following table
describes when these events occur in Arbortext Editor and the Arbortext

Publishing Engine:

Event
DOMFocusIn

DOMFocusOut

Events

Occurrence

Two occurrences:

When the cursor of the view that
has keyboard input focus moves
into an event target.

When the keyboard input focus
switches from another view to the
current view while the cursor of the
current view is inside an event
target.

Two occurrences:

When the cursor of the view that
has keyboard input focus moves out
of an event target.

When the keyboard input focus
switches from the current view to
another view while the cursor of the
current view is inside an event
target.
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Event
DOMActivate

DOMSubtreeModified

Occurrence

When an event target is activated
through a mouse double-click.

For a XUI document, this event will be
dispatched when its corresponding
dialog box state changes, such as when
a check box is selected, an item of a list
box is selected, a push button is
pressed, and so on.

Certain user interface actions like Insert
» Markup can result in multiple
changes to the document; only a single
DOMSubtreeModified event will
be fired in those cases.

Refer to Event Types on page 131 for a description of each event type.

Notes and Limitations

The following notes and limitations apply to the Arbortext Editor and the
Arbortext Publishing Engine implementations of events:

* Be aware that DOM mutation events trigger after the document is loaded and
something happens to change the document, not as the document is being read
in by Arbortext Editor or the Arbortext Publishing Engine.

* HTML-specific features in the W3C DOM Events specification are not

implemented.

* No mutation events are currently fired for undo or redo operations. Instead the

AOMUndo event type is dispatched.

* SGML-specific document structures such as ignored marked sections are not
supported by the Arbortext Editor and the Arbortext Publishing Engine DOM

implementation.

Event Handlers

Event handlers are registered in a binding-specific manner. The following sections
illustrate the techniques used to implement the EventListener interface for each
language binding supported by Arbortext Editor and the Arbortext Publishing

Engine.
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The example (repeated in each binding) shows how to register a mouse click
handler (of the MouseEvents event module) for the active document. The
handler prints a line to the message window showing the element hierarchy in the
following form each time the mouse is clicked within the document:

(book (chapter (para

Java

In Java, it is necessary to cast the Document object to call the
addEventListener method of the EventTarget interface. Also, note the event
listener parameter is specified using an anonymous inner class.

Document doc = Application.getActiveDocument () ;

((EventTarget)doc) .addEventListener ("click",

new EventListener () {

public void handleEvent (Event event) {

Node node = (Node)event.getTarget():;

String context = "";

while (node != null) {

if (node.getNodeType () == Node.ELEMENT NODE) ({
context = " (" + node.getNodeName () + context;
}

node = node.getParentNode () ;

}
Application.print (context + "\n");
event.stopPropagation () ;

}, true);

JavaScript

JavaScript uses the LiveConnect feature to connect to Java to create the DOM
EventListener object to pass to addEventListener. The handler object
associated with the EventListener is declared using object literal syntax.
function clickEvent (event)

{

var node = event.target;

var context = "";

while (node != null) {

if (node.nodeType == node.ELEMENT NODE) {

context = " (" + node.nodeName + context;

}

node = node.parentNode;

}

Application.print (context + "\n");

event.stopPropagation () ;

}
var doc = Application.activeDocument;

// define an object with the required handleEvent method
var o = { handleEvent: clickEvent};
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var listener = Packages.org.w3c.dom.events.EventListener (o) ;
doc.addEventListener ("click", listener, true);

JScript

In JScript, the EventListener interface is implemented by declaring a constructor
of the same name. Note, that because of the way JScript works, the interface
constants like Node.ELEMENT_NODE are not available. Otherwise, the
clickEvent function is the same as the in the JavaScript example. The main
difference is in how the listener object is created.

function EventListener( )

{

this.handleEvent = clickEvent;
}
function clickEvent (event)
{

var node = event.target;

var context = "";

|

while (node != null) {

if (node.nodeType == 1 /*ELEMENT NODE*/) {
context = " (" + node.nodeName + context;

}

node = node.parentNode;

}

Application.print (context + "\n");
event.stopPropagation () ;

}

var doc = Application.activeDocument;

var listener = new EventListener();
doc.addEventListener ("click", listener, true);

VBScript

In VBScript, the event handler is declared as a class:
Class EventListener

Public Function handleEvent (ByVal evt)

Dim node

set node = evt.target

Dim context

context = ""

While Not node Is Nothing

If node.nodeType = 1 Then

context = " (" & node.nodeName & context
End If

Set node = node.parentNode

Wend

Application.print (context)
Application.print ()
evt.stopPropagation ()
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handleEvent = 0

End Function

End Class

Dim doc

set doc = Application.activeDocument

Dim listener

set listener = new EventListener
doc.addEventListener "click", listener, true

Visual Basic

In Visual Basic, the event handler is created as a listener class with the following
code. Note that Print is a reserved method name in Visual Basic, so the
Application.Print method is not available; the VB Debug.Print
method is used instead.
Option Explicit
Implements IDOMEventListener
Private Sub IDOMEventListener handleEvent

(ByVal evt As IDOMEvent)

Dim node As IDOMNode3

Set node = evt.target

Dim context As String

context = ""

While Not node Is Nothing

If node.nodeType = NODE ELEMENT Then

context = " (" & node.nodeName & context
End If

Set node = node.parentNode

Wend

Debug.Print context
evt.stopPropagation
End Sub

Then a Visual Basic form must be created with this code included to register the
event listener:
Option Explicit
Dim myListener As IDOMEventListener
Dim app As Epic.Application
Dim activeDoc As DOMDocument
Dim target As IDOMEventTarget
Private Sub Form Load()
Set myListener = New Listener
Set app = New Epic.Application
Set activeDoc = app.ActiveDocument
Set target = activeDoc
target.addEventListener "click", myListener, False
End Sub
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COM C++

Much of the COM C++ example was generated automatically using the Insert »
New ATL Object menu in the Microsoft Visual C++ IDE followed by Implement
Interface on the CListener class added by New ATL Object. This was edited so
both the raw methods and the method wrappers were created by the # import
statement.

The listener class declaration is:

#ifndef  LISTENER H

#define  LISTENER H

#include "resource.h" // main symbols

#import "epic.exe" raw native types, no namespace, named guids

class ATL NO VTABLE CListener
public CComObjectRootEx<CComSingleThreadModel>,
public IDispatchImpl<IDOMEventListener,

&IID IDOMEventListener, &LIBID Epic>
{
public:

CListener ()

{

}

DECLARE_NO_REGISTRY()

DECLARE PROTECT_ FINAL CONSTRUCT ()

BEGIN COM MAP (CListener)
COM_INTERFACE_ENTRY(IDiSpatch)
COM_INTERFACE_ENTRY(IDOMEventListener)

END COM MAP ()

public:

STDMETHOD (raw_handleEvent) (IDOMEvent * evt);

}i

#endif //_ LISTENER H

The listener implementation class is:
#include "stdafx.h"
#include "Listener.h"
#include <string>
typedef std::basic_string< unsigned short > DOMString;
STDMETHODIMP CListener::raw_handleEvent ( IDOMEvent *rawEvent)
{

IDOMEventPtr pEvent = rawEvent;

IDOMNode3Ptr pNode = pEvent->target;

DOMString context;

while (pNode)

{

if (pNode->nodeType == NODE ELEMENT)

{

context.insert (0, pNode->nodeName) ;

context.insert (0, L"(");

}

pNode = pNode->parentNode;
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}

_Application3Ptr pEpic( uuidof (Application));
context += L"\n";
pEpic->Print (_variant t(context.c str()));
pEvent->stopPropagation () ;

return S _OK;

}

The method that creates and attaches the listener is:
void AttachListener ()
{

CListener *pListener = new CComObject<CListener>;
IDOMEventListenerPtr pIntfc;
if (pListener)

{
plListener->QueryInterface (IID IDOMEventListener,

(void **) &pIntfc);

_Application3Ptr pEpic(_ uuidof (Application));
IDOMEventTargetPtr pDocTarget;

pDocTarget = pEpic->ActiveDocument;
pDocTarget->addEventListener ( bstr t("click"), pIntfc, true);

Event Types

The following sections define the event types supported by each event module and
include information about event bubbling, event cancellation, and specific context
information for each event type.

The descriptions of the W3C modules (UIEvent, MouseEvent, and MutationEvent)
in the following sections are taken from the Document Object Model (DOM)
Level 2 Events Specification (www.w3.org/TR/DOM-Level-2-Events).

UIEvent Module

The W3C UlEvent module has the following event types:

DOMFocusIn
The DOMFocusIn event occurs when an EventTarget receives focus, for
instance by a pointing device being moved onto an element or by tabbing
navigation to the element. Unlike the HTML event focus, DOMFocusIn
can be applied to any focusable EventTarget, not just FORM controls.

* Bubbles: Yes
* Cancelable: No

¢  Context Info: None
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DOMFocusOut
The DOMFocusOut event occurs when an EventTarget loses focus, for
instance by a pointing device being moved out of an element or by tabbing
navigation out of the element. Unlike the HTML event blur,
DOMFocusOut can be applied to any focusable EventTarget , not just

FORM controls.
* Bubbles: Yes
* (Cancelable: No
* Context Info: None
DOMActivate
The activate event occurs when an element is activated, for instance, through a
mouse click or a key press. A numerical argument is provided to give an
indication of the type of activation that occurs: 1 for a simple activation (for

example, a simple click or Enter), 2 for hyperactivation (for example, a double
click or Shift Enter).

* Bubbles: Yes
* Cancelable: Yes

* Context Info: detail (the numerical value)

MouseEvent Module
The W3C MouseEvent module has the following event types:

click
The c1ick event occurs when the pointing device button is clicked over an
element. A click is defined as a mousedown and mouseup over the same
screen location. The sequence of these events is:

mousedown
mouseup
click

If multiple clicks occur at the same screen location, the sequence repeats with
the detail attribute incrementing with each repetition. This event is valid for
most elements.

* Bubbles: Yes
* Cancelable: Yes

* Context Info: screenX, screen?, clientX, clientY, altKey, ctrlKey, shiftKey,
metaKey, button, detail

mousedown
The mousedown event occurs when the pointing device button is pressed
over an element. This event is valid for most elements.
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Bubbles: Yes
Cancelable: Yes

Context Info: screenX, screen?Y, clientX, clientY, altKey, ctriKey, shiftKey,
metaKey, button, detail

mouseup

The mouseup event occurs when the pointing device button is released over
an element. This event is valid for most elements.

L]

Bubbles: Yes
Cancelable: Yes

Context Info: screenX, screenY, clientX, clientY, altKey, ctriKey, shiftKey,
metaKey, button, detail

mouseover

The mouseover event occurs when the pointing device is moved onto an
element. This event is valid for most elements.

L]

Bubbles: Yes
Cancelable: Yes

Context Info: screenX, screenY, clientX, clientY, altKey, ctriKey, shiftKey,
metaKey, relatedTarget indicates the EventTarget the pointing device
is exiting.

mousemove
The mousemove event occurs when the pointing device is moved while it is
over an element. This event is valid for most elements.

Bubbles: Yes
Cancelable: No

Context Info: screenX, screen?Y, clientX, clientY, altKey, ctriKey, shiftKey,
metaKey

mouseout

The mouseout event occurs when the pointing device is moved away from
an element. This event is valid for most elements.

L]

Events

Bubbles: Yes
Cancelable: Yes

Context Info: screenX, screenY, clientX, clientY, altKey, ctriKey, shifiKey,
metaKey, relatedTarget indicates the EventTarget the pointing device
is entering.
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MutationEvent Module
The W3C MutationEvent module has the following event types:

DOMSubtreeModified

This is a general event for notification of all changes to the document. It can
be used instead of the more specific events listed below. It may be fired after a
single modification to the document or, at the implementation's discretion,
after multiple changes have occurred. The latter use should generally be used
to accommodate multiple changes which occur either simultaneously or in
rapid succession. The target of this event is the lowest common parent of the
changes which have taken place. This event is dispatched after any other
events caused by the mutation have fired.

* Bubbles: Yes
* Cancelable: No

¢  Context Info: None

DOMNodelnserted

Fired when a node has been added as a child of another node. This event is
dispatched after the insertion has taken place. The target of this event is the
node being inserted.

* Bubbles: Yes
* (Cancelable: No
* Context Info: relatedNode holds the parent node

DOMNodeRemoved

Fired when a node is being removed from its parent node. This event is
dispatched before the node is removed from the tree. The target of this event is
the node being removed.

* Bubbles: Yes
* Cancelable: No
* Context Info: relatedNode holds the parent node

DOMNodeRemovedFromDocument
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Fired when a node is being removed from a document, either through direct
removal of the Node or removal of a subtree in which it is contained. This
event is dispatched before the removal takes place. The target of this event is
the Node being removed. If the Node is being directly removed the
DOMNodeRemoved event will fire before the
DOMNodeRemovedFromDocument event.
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* Bubbles: No
* Cancelable: No
*  Context Info: None

DOMNodelnsertedIntoDocument
Fired when a node is being inserted into a document, either through direct
insertion of the Node or insertion of a subtree in which it is contained. This
event is dispatched after the insertion has taken place. The target of this event
is the node being inserted. If the Node is being directly inserted the
DOMNodeInserted event will fire before the
DOMNodeInsertedIntoDocument event.
* Bubbles: No
* (Cancelable: No
* Context Info: None

DOMACttrModified
Fired after an At t r has been modified on a node. The target of this event is
the Node whose At tr changed. The value of attrChange indicates whether
the At tr was modified, added, or removed. The value of relatedNode
indicates the At t r node whose value has been affected. It is expected that
string based replacement of an At t r value will be viewed as a modification
of the At tr since its identity does not change. Subsequently replacement of
the At tr node with a different At t r node is viewed as the removal of the
first At tr node and the addition of the second.
* Bubbles: Yes
* Cancelable: No
*  Context Info: attrName, attrChange, prevValue, newValue, relatedNode

DOMCharacterDataModified
Fired after CharacterData within a node has been modified but the node itself
has not been inserted or deleted. This event is also triggered by modifications
to PI elements. The target of this event is the CharacterData node.

* Bubbles: Yes
* Cancelable: No

* Context Info: prevValue, newValue

AEditEvent Module

The AEditEvent extension to the Event interface includes the following event
types:
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AOMCut

The AOMCut event occurs before a cut operation is executed. If an event
listener doesn't cancel the cut, proper mutation events will be fired after the cut
has taken place.

Bubbles: Yes
Cancelable: Yes

Context Info: relatedRange holds the range that is going to be removed
from the document.

AOMCopy
The AOMCopy event occurs before the copy operation is executed.

Bubbles: Yes
Cancelable: Yes

Context Info: relatedRange holds the range that is going to be copied.

AOMDeleteRegion

The AOMDeleteRegion is called before an attempt to delete a contiguous
region of a document in an edit window. AOMDe 1 eteRegion parallels the
delete region ACL callback type, and is dispatched immediately before
that callback is invoked. Refer to the delete region documentation for
details on when and how this event is fired.

Bubbles: Yes

Cancelable: Based on the method by which the content was removed:
true in cases where detail does not contain 0x08, and false if detail
does contain 0x08. Refer to the description of delete region for
additional details. Calling preventDefault if the event is not
cancelable will have no effect.

Context Info: relatedRange holds the range containing the content about to
be deleted. The detail field holds a value identical to the flags parameter to
the delete region callback.

AOMPaste
The AOMPaste event occurs after the paste operation has been executed.
Proper mutation events are fired together with the paste event.
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Bubbles: Yes
Cancelable: No

Context Info: relatedRange holds the range that is newly inserted into the
document by the paste operation. detail indicates the source of the paste
content: 1 for Arbortext Editor, 2 for clipboard.
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AOMUndo
The AOMUndo event occurs after the undo operation executes. Currently, no
mutation events are fired for the undo.

* Bubbles: Yes
¢ (Cancelable: No

*  Context Info: relatedRange holds the range that is affected by the undo
operation. detail indicates the source of the undo: 1 for the undo command,
2 for the undo triggered by Arbortext Editor as the result of context errors,
3 for the redo command.

ApplicationEvent Module

The ApplicationEvent extension to the ApplicationEvent interface includes the
following event types:

ApplicationLoad
The ApplicationLoad event occurs after Arbortext Editor is initialized
and all the startup files in the custom directories have been executed. There is
no ACL callback equivalent for this event.

ApplicationEvent event listeners need to be registered before Arbortext
software is fully loaded. Therefore, a good place to register an
ApplicationLoad event listener is in a startup file in the custom directory.

* Bubbles: No
* Cancelable: No

*  Context Info: None

ApplicationClosing
The ApplicationClosing event occurs when the user closes down the

Arbortext software. This event type is similar to the ACL session quit
callback.

This event type is cancelable. If an event listener calls the
preventDefault method, the closing will be cancelled.

The detail indicates whether the Arbortext software will prompt for document
changes or not:

* 0: prompts for any changes.
* 1:saves all modified documents without prompting.

* 2:doesn't prompt for unsaved changes and quits without saving modified
documents.
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* Bubbles: No
* Cancelable: Yes
¢ Context Info: detail

ADocumentEvent Module

The ADocumentEvent extension to the Event interface includes the following
event types:

DocumentCreated

The DocumentCreated event occurs after a document is constructed and
before any document instance startup files are executed. This event type is
similar to the ACL document create callback. However, the ACL document
create callback is called after document instance startup files are executed;
the DocumentCreated event is called before the startup files are executed.

It is impossible to register a DocumentCreated event listener in a
Document object. If the Document object exists, the document has already
been created. DocumentCreated event listeners need to be registered in the
Application object.

The detail attribute indicates whether the document is empty or not:

¢ 0:if the document is constructed from a source file.

1: if the document is empty.
* Bubbles: Yes

* (Cancelable: No

*  Context Info: detail

DocumentClosed

The DocumentClosed event occurs when a document is destroyed. This
event is similar to the ACL document destroy callback.

* Bubbles: Yes
* Cancelable: No

*  Context Info: None

DocumentLoad
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The DocumentLoad event occurs when a document is loaded into a window
frame and all document instance startup files have been executed. This event
is similar to ACL editfilehook hook.

When a new window frame is launched, a DocumentLoad event will be
dispatched for the document displayed in the new window frame.
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A window frame can have more than one view. A DocumentLoad event will
only be dispatched if a document is loaded into a window frame and the
document does not already have a view in that window frame.

A document can be loaded into two or more different window frames. A
DocumentLoad event will be dispatched when a document is loaded into a
window frame event if the same document is already displayed in another
window frame.

relatedWindow specifies the window frame into which the document is
loaded.

* Bubbles: Yes
¢ Cancelable: No

¢ Context Info: relatedWindow

DocumentUnload
The DocumentUnload event occurs when a document is unloaded from a
window frame. There is no ACL callback equivalent for this event.

A DocumentUnload event will only be dispatched if a document is
unloaded from a window frame and the document does not have another view
in that window frame.

relatedWindow specifies the window frame from which the document is
unloaded. relatedWindow is not set if the window frame is also being
destroyed.

* Bubbles: Yes
* Cancelable: No

¢ Context Info: relatedWindow if the window frame still exists.
Otherwise, null.

DocumentSaving
The DocumentSaving event occurs when the user saves a document. This
event type covers ACL document save and saveas callbacks. The write
command does not cause any ACL callbacks to be called, but it triggers the
DocumentSaving event.

This event type is cancelable. If an event listener calls the
preventDefault method, the save will be canceled. The user can cancel
the save and call the ADocument Save method in the event listener to save
the document. This is useful when some actions need to be done before or
after the save.

The targetURT specifies the path the document is saved in. The
targetEncoding specifies the encoding the document is saved in.

The detail indicates the command that caused the event:
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* 0:if the event is caused by a save command.

* 1:if the event is caused by a saveas command.

» 2:if'the event is caused by a write command.

* Bubbles: Yes

* (Cancelable: No

* Context Info: targetURI, targetEncoding, detail

ADocumentEntityEvent Module

The ADocumentEntityEvent extension to the Event interface includes the following
event type:

EntityDeclConflict
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The EntityDeclConflict event occurs when an entity declaration in an
internal subset conflicts with one in an external subset (usually a DTD) or with
one in a referencing parent document. This event type is similar to the
entitydeclconflict ACL callback.

The following module properties provide the context information for this
event:

object

The CMSObject in which the declaration was found.
relatedDocument

The Document in which the declaration was found.
relatedNode

DOM Ent ity containing information about the entity declaration.

To avoid the default behavior (which is to ignore the conflicting entity
declaration), the event handler must set the result property to specify an
alternative entity name as well as call preventDefault. Evenif result
is set and preventDefaultis called, the conflicting declaration will still be
ignored if any of the following are true:

* result was set to a blank or null string.
* result was set to a name which conflicts with an already existing entity.

* result was set to an invalid entity name.

~ Note

Setting result without calling preventDefault will cause the result
to be ignored and the default processing to proceed.
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* Bubbles: Yes
* Cancelable: Yes

* Context Info: object, relatedDocument, relatedNode

WindowEvent Module

The WindowEvent module has the following event types:

WindowCreated
The WindowCreated event occurs when a window is created. This event is
similar to the ACL window create callback.

It is impossible to register a WindowCreated event listener in a Window
object; if the Window object exists, the window has already been created.
WindowCreated event listeners need to be registered in the
Application object.

The WindowCreated event type bubbles to the Application object.
* Bubbles: Yes
¢ Cancelable: No

¢ Context Info: None

WindowLoad
This event type is triggered when a window is opened at the first time.

The WindowLoad event type bubbles to the Application object.
* Bubbles: No
* Cancelable: No

¢ Context Info: None

WindowClosing
This event type is triggered when the user requests a window be closed
through the system menu, through a close button on a window's title bar, or
through a platform-defined keystroke, such as Alt-F4 on Windows.

The WindowClosing event type bubbles to the Application object.
* Bubbles: No
» Cancelable: Yes

¢ Context Info: None

WindowClosed
This event type is triggered after a window is disposed.

The WindowClosed event type bubbles to the Application object.
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* Bubbles: No
* Cancelable: No

¢ Context Info: None

WindowActivated
This event type is triggered when a window is activated, that is, when it is
given the keyboard focus and becomes the active window.

The WindowActivated event type bubbles to the Application object.
+ Bubbles: No

* Cancelable: No

* Context Info: None

WindowDeactivated
This event type is triggered when a window ceases to be the active window.

The WindowDeactivated event type bubbles to the Application
object.

* Bubbles: No
* Cancelable: No
¢ Context Info: None

WindowMinimized
This event type is triggered when the user minimizes a window.

The WindowMinimized event type bubbles to the Application object.
* Bubbles: No

* (Cancelable: No

*  Context Info: None

WindowRestored
This event type is triggered when a window is restored from a minimized state
to its previous displayed window size and position.

The WindowRestored event type bubbles to the Application object.

* Bubbles: No
¢ Cancelable: No

*  Context Info: None

MenuEvent Module

The MenuEvent module has the following event types:
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MenuPost
This event is dispatched before a menu item is displayed. The target of the
event is the MenuItem being displayed. This event provides an opportunity
for application programmers to disable or enable the menu item based on the
nature of the current document or current cursor location.

* Bubbles: No
* Cancelable: No

*  Context Info: None

MenuSelected
This event is dispatched when a menu item is selected. The target of the event
is the MenuItem being selected. The default action of this event is to execute
the ACL commands attached to the menu item. If the preventDefault
method is called, the default action will not occur.

* Bubbles: No
* Cancelable: Yes

*  Context Info: None

CMSObjectEvent Module

The CMSObjectEvent module has the following event types:

CMSObjectPreCheckin
This event occurs before an object is checked in and before any supporting
calls have been made. This event is similar to the precheckin ACL
callback associated with the sess add callback function.

This event type is cancelable. If an event listener calls the
preventDefault method, the checkin will be canceled. The event handler
can perform a customized checkin itself and then cancel the default checkin by
calling preventDefault and setting result to the result of the checkin.

~ Note

Setting result without calling preventDefault will cause the result
to be ignored and the default processing to proceed.

* Bubbles: Yes
* Cancelable: Yes

*  Context Info: None
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CMSObjectCheckin
This event occurs before an object is checked in and after some transactional
and bursting calls have been made. Specifically, if the adapter supports
transactions, a transaction will have been already started, and if the adapter
specifies that objects should be burst on checkin then this bursting will already
have occurred. If bursting modified the object contents, the object will also
have been saved back to the repository.

This event is similar to the checkin ACL callback associated with the
sess _add callback function.

This event type is cancelable. If an event listener calls the
preventDefault method, the checkin will be canceled. In this case, the
pending transaction (if supported) will be rolled back.

The event handler can perform a customized checkin itself and then cancel the
default checkin by calling preventDefault and setting result to the
result of the checkin. In this case, the specified result will be used and the
transaction will be committed.

~ Note

Setting result without calling preventDefault will cause the result
to be ignored and the default processing to proceed.

* Bubbles: Yes
* (Cancelable: Yes

¢  Context Info: None

CMSODbjectPostCheckin
This event occurs after an object has been checked in. As such, it is not
cancelable. There is no equivalent ACL hook for this event.

The following module property provides the context information for this
event:

result
* Represents the object that has been checked in.
O Bubbles: Yes

O Cancelable: No
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O  Context Info: result

CMSODbjectCheckout
This event occurs before an object has been checked out. This event is similar
to the 1lock ACL callback associated with the sess _add callback
function.

This event type is cancelable. If an event listener calls the
preventDefault method, the checkout will be canceled. The event
handler can perform a customized checkout itself and then cancel the default
checkout by calling preventDefault and setting result to the result of
the checkout.

~ Note

Setting result without calling preventDefault will cause the result
to be ignored and the default processing to proceed.

The following module property provides the context information for this
event:

flags

Defined according to the flags parameter of the CMSObject.checkout
method.

* Bubbles: Yes
* Cancelable: Yes

*  Context Info: flags

CMSODbjectPostCheckout
This event occurs after an object has been checked out. As such, it is not
cancelable. There is no equivalent ACL hook for this event.

The following module property provides the context information for this
event:
result

Represents the object that has been checked out.
* Bubbles: Yes

* Cancelable: Yes

*  Context Info: result
CMSObjectCancelCheckout
This event occurs before an object's checkout has been canceled. This event is

similar to the unlock ACL callback associated with the sess add
callback function.
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This event type is cancelable. If an event listener calls the
preventDefault method, the checkout will remain. The event handler can
perform a customized cancellation of the checkout itself and then cancel the
default behavior by calling preventDefault and setting result to the
result of the canceled checkout.

~ Note

Setting result without calling preventDefault will cause the result
to be ignored and the default processing to proceed.

* Bubbles: Yes
¢ (Cancelable: Yes

¢ Context Info: None

CMSODbjectPostCancelCheckout

This event occurs after an object's checkout has been canceled. As such, it is
not cancelable. There is no equivalent ACL hook for this event.

The following module property provides the context information for this
event:
result

Represents the object whose checkout has been canceled.
* Bubbles: Yes
» Cancelable: No

¢ Context Info: result

CMSObjectSave
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This event occurs before an object has been saved. This event is similar to the
save ACL callback associated with the sess add callback function.
This event type is cancelable. If an event listener calls the
preventDefault method, the save will be canceled. The event handler can

perform a customized save itself and then cancel the default save by calling
preventDefault and setting result to the result of the save.

~ Note

Setting result without calling preventDefault will cause the result
to be ignored and the default processing to proceed.

The following module properties provide the context information for this
event:
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flags

Defined according to the flags parameter of the CMSObject . save method.
start

Along with end, represents the content being saved.
end

Along with start, represents the content being saved.
* Bubbles: Yes

* (Cancelable: Yes

* Context Info: flags, start, end

CMSODbjectPostSave
This event occurs after an object has been saved. As such, it is not cancelable.
There is no equivalent ACL hook for this event.

The following module property provides the context information for this
event:
result

Represents the object that has been saved.
¢ Bubbles: Yes
e Cancelable: No

¢ Context Info: result

CMSSessionConstructEvent Module
The CMSSessionConstructEvent module has the following event types:

CMSSessionPostConstructObject
This event occurs after an object has been constructed. As such, it is not
cancelable. There is no equivalent ACL hook for this event.

The following module property provides the context information for this
event:
result

Represents the CMSObJject which has been constructed.
* Bubbles: Yes
* Cancelable: No

¢ Context Info: result
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CMSSessionCreateEvent Module

The CMSSessionCreateEvent module has the following event types:

CMSSessionCreateNewObject
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This event occurs before a new repository object is created. This event is
similar to the create ACL callback associated with the sess add
callback function. Modifying the name or folderLogicalId
arguments is functionally equivalent to the ACL object naming and object
location hooks specified in burst configuration files.

This event type is cancelable. If an event listener calls the
preventDefault method, the object will not be created. The event handler
can perform a customized creation itself and then cancel the default creation
by calling preventDefault and setting result to the result of the
construction.

~ Note

Setting result without calling preventDefault will cause the result
to be ignored and the default processing to proceed.

The following module properties provide the context information for this
event:

name

Represents the name of the object being created.

type

Represents an adapter-specific object type string.

folderLogicalId

Represents the parent folder for the new object.

flags

Same as the flags parameter of the CMSSession.createNewObject
method.
start

Along with end, represents the content of the new object.
end

Along with start, represents the content of the new object.
version

Represents an adapter-specific version for the new object.
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* Bubbles: Yes
* Cancelable: Yes

* Context Info: name, type, folderLogicalld, flags, start, end,
version

CMSSessionPostCreateNewObject
This event occurs after an object has been created. As such, it is not
cancelable. There is no equivalent ACL hook for this event.

The following module property provides the context information for this
event:

result
Represents the CMSOb-ject which has been constructed.

* Bubbles: Yes
* (Cancelable: No

¢ Context Info: result

CMSSessionFileEvent Module

The CMSSessionFileEvent module has the following event types:

CMSSessionGetFile
This event occurs before the content of a repository object is downloaded to a
local disk file. This event is similar to the get £i1e ACL callback associated
with the sess add callback function.

This event type is cancelable. If an event listener calls the
preventDefault method, the object will not be downloaded. The event
handler can perform a customized download itself and then cancel the default
download by calling preventDefault and setting result to specify a
local disk file containing the object content.

~ Note

Setting result without calling preventDefault will cause the result
to be ignored and the default processing to proceed.

The following module properties provide the context information for this
event:

logicallId

Represents the object whose content is desired.
notation

Events 149



Represents an adapter-specific format specification.
* Bubbles: Yes
* Cancelable: Yes

* Context Info: logicalId, notation

CMSSessionPostGetFile

This event occurs after an object's content has been downloaded. As such, it is
not cancelable. There is no equivalent ACL hook for this event.

The following module properties provide the context information for this
event:

logicalld

Represents the object whose content is desired.
notation

Represents an adapter-specific format specification.
localPath

Represents the local disk file containing the object content.

* Bubbles: Yes
e Cancelable: No
* Context Info: logicalId, notation, localPath

CMSSessionPutFile
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This event occurs before a new repository object is created from the contents
of a local file or other resource. This event is similar to the putfile ACL
callback associated with the sess add callback function.

This event type is cancelable. If an event listener calls the
preventDefault method, the object will not be created. The event handler
can perform a customized creation itself and then cancel the default creation
by calling preventDefault and setting result to specify the logical id
of the new object.

~ Note

Setting result without calling preventDefault will cause the result
to be ignored and the default processing to proceed.

The following module properties provide the context information for this
event:

localPath

Represents the local resource whose content will go into the new object.
notation
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Represents an adapter-specific format specification.
objectName

Represents the name of the new object.
folderLogicalId

Represents the parent folder of the new object.

* Bubbles: Yes
* Cancelable: Yes

* Context Info: localPath, notation, objectName,
folderLogicalld

CMSSessionPostPutFile
This event occurs after the new object has been created with the contents of a
local resource. As such, it is not cancelable. There is no equivalent ACL hook
for this event.

The following module properties provide the context information for this
event:
localPath

Represents the local resource whose content went into the new object.
notation

Represents an adapter-specific format specification.
logicalld

Represents the logical id of the new object.

* Bubbles: Yes

* (Cancelable: No

* Context Info: localPath, notation, logicalId

CMSSessionBurstEvent Module

The CMSSessionBurstEvent module has the following event types:

CMSSessionBurstDocument
This event occurs before a document is burst into the repository. There is no
equivalent ACL hook for this event.

The event handler's ability to assign new values to the topLevelName and
folderLogicalId properties can replace object location and naming rule

hooks, which are implemented as inline ACL code in a burst configuration
file.
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This event type is cancelable. If an event listener calls the
preventDefault method, the burst will be canceled. In this case, the
pending transaction (if supported) will be rolled back.

The following module properties provide the context information for this
event:

canOverride

Represents whether the event handler is allowed to override the
topLevelName and folderLogicalId properties. If canOverride is
false, then any changes to these properties will have no effect. If
canOverride is true, then the event handler can set new values for these
properties if desired.

topLevelName

Represents the name of the top-level object which will result from bursting the
document. This may be null or empty which means the name will be auto-
generated according to the bursting rules for this adapter. The event handler
can override this value if canOverzride is true.

folderLogicalld

Represents the repository folder which will hold the top-level object which
will result from bursting the document. This may be null or empty which
means the folder will be chosen according to the bursting rules for this adapter.
The event handler can override this value if canOverride is true.

document

Represents the document being burst.
flags

Same as the flags parameter to the CMSSession.burstDocument
method.

* Bubbles: Yes
* Cancelable: Yes

* Context Info: canOverride, topLevelName, folderLogicalld,
document, flags

CMSSessionPostBurstDocument
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This event occurs after a document has been burst. As such, it is not
cancelable. There is no equivalent ACL hook for this event.

The following module property provides the context information for this
event:

document

Represents the document which has been burst.
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* Bubbles: Yes
* Cancelable: No

¢ Context Info: document

CMSSessionDisconnectEvent Module
The CMSSessionDisconnectEvent module has the following event type:

CMSSessionPreDisconnect
This event occurs before a a user logs off the repository. There is no equivalent
ACL hook for this event. This event type is not cancelable.

The following module property provides the context information for this
event:

currentUser

Specifies the current CMS user name. This will normally match the 1oginId
parameter to the CMSAdapter.connect method which established this
session.

* Bubbles: Yes
* Cancelable: No

¢ Context Info: currentUser

CMSAdapterConnectEvent Module

The CMSAdapterConnectEvent module has the following event type:

CMSAdapterPreConnect
This event occurs before the adapter's connect method is invoked. An
associated event handler can ensure any resource dependencies are satisfied.

This event type is cancelable. If an event listener calls the

preventDefault method, the adapter’s connect method will not be
called.

No context information is provided for this event.

* Bubbles: Yes

* Cancelable: Yes

CMSAdapterDisconnectEvent Module

The CMSAdapterDisconnectEvent module has the following event type:
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CMSAdapterPostDisconnect
This event occurs after a session has successfully logged off the CMS, and as
such is not cancelable. An associated event handler can be used to clean up
any resource dependencies. The event CMSSessionPreDisconnect
occurs before the user logs off the repository. When
CMSAdapterPostDisconnect occurs, the session is invalid, and thus
appears in a separate interface.

The following module property provides the context information for this
event:

currentUser

Specifies the current CMS user name. This will normally match the 1oginId
parameter to the CMSAdapter.connect method which established this
session.

* Bubbles: Yes
* Cancelable: No

¢ Context Info: currentUser
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Working with Tables Overview

The AOM contains interfaces that provide access to more than 100 Arbortext
Editor table functions. With these interfaces, you can programmatically create and
modify tables in any Arbortext Editor document using Java, JavaScript, VB, or
VBScript. The entire Arbortext Editor table object model is exposed through the
following set of interfaces:

Interface Description

TableCell A cell in a table.

TableCol i
ableColumn A column in a table.

TableException .
Xcept The Exception type thrown when an

error is encountered.

TableGrid In the Oasis Exchange Table model, a

table consists of one or more grids,
each of which can have a unique
number of rows and columns. In the
HTML and Arbortext table models, the
grid is the sum of all the table rows and
columns. This interface allows
operation on those grids.

TableMulticell .
ableMultice A rectangular array of spanned cells in

a table.

TableObject .
. The superinterface for TableCell,

TableColumn, TableGrid,
TableObjectStore, TableRow, TableRule,
TableSet, and TableTilePlex.

TableObjectStore A collection of TableObjects.

TableRectangle .
9 A rectangle of contiguous cells.

TableR i
ableRow A row in a table.
TableRul i
ableRule A rule in a table.
Tabl i
ableSet A collection of one or more TableGrids.
TableTilePlex

A collection representing a table
selection.

The following three code samples illustrate the basics of inserting and
manipulating tables using these interfaces. The sample code is in JavaScript. The
code will also work using the Microsoft JScript Engine with the noted
modifications.
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Example: Inserting and Modifying a Table
This example uses the function addTable to perform the following actions:

» Insert a six-row five-column table into the first paragraph of a Arbortext XML
Docbook template.

* Span cells 1-2 and 3-5 of the first row and add text to the spanned cells.
* Convert the first row to a header row.

* Turn off rules for the entire table.

The function appendText is a utility function for adding text to a cell.

To run this sample code:

1. Copy addTable and appendText to a file named addtable. js in
Arbortext-path\custom\scripts.

2. Start Arbortext Editor, open a Arbortext XML Docbook template, and enter

the following commands at the Arbortext Editor command line:
source addtable.js
Jjs addtable

// Function: appendText

//

// Description: A utility function called by addTable.
// Adds text to a cell

//

// Parameters: cell: the target for the added text

// text: the text to be added

//

/= e e
function appendText (cell, text)

{

var cellRange = cell.contents;

cellRange.collapse( false );

var textNode = cell.document.createTextNode (text) ;

cellRange.insertNode (textNode) ;

// Function: addTable

//

// Description: Add a table to the first para in a document
//

// Parameters: NONE

//

/==
function addTable () {

var doc = Application.activeDocument;

var para = doc.getElementsByTagName ("para").item(0);
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try{

var set = para.insertTable ("OASIS Exchange", "table", 5, 6, null);
}

catch(e) {Application.alert ("Exception " + e.code() +
" caught in insertTable");

return 0;}

var grid = set.grids.item(0);

var firstRow = grid.row(l);

// Span cells 1-2 and 3-5

firstRow.cell(l) .span(firstRow.cell(2));
firstRow.cell (3) .span(firstRow.cell (5));

appendText (firstRow.cell (1), "Cells 1 and 2");
appendText (firstRow.cell (3), "Cells 3-5");

// Change first row to a header row
firstRow.setAttribute ("header level",1);

//turn off the table rules

var rules = grid.rules;

for (i = 0; i < rules.length; i++) {

rules.item(i) .setAttribute ("style", "blank");

}
}//end of addTable

Example: Inserting a Column Based on
the Current Selection

This example uses the function tbl insert column to inserta column to the
left of the current selection. If the selection is invalid, that is, it is discontiguous or
not a rectangle, a message is displayed in a dialog box and tbl insert
column returns zero.

To run this sample code:

1. Copythe tbl insert column code to a